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.. Clear your browsers cache and cookles;

1. 1. Open the Tools menu and seledt Internet Options.
2. 2. On the General tab, in the section labeled Temporary Internet files, dlick on the Delete Cookies bulton and answer OK.
3 3 Click on the Delete Files button, check the box which reads Delate AH Offiine Gontent and answer OK. {Please note, if your

have nol recenlly cleared your file cache, it may take several minutes for this process to finish.)
O..Ensure that your browser uses 128-bit encryption for secure connections:
1. Dpen the Help menu and select About internet Explorer.
2. 2. Verify that the Cipher Strength value is 128-bit
0.+ Sel secuily settings:
1. 1. Open the Teols menw and selact Internet Options,

2. 2. Dnthe Advanced tab, seroll to the Security secfion and check setiings for 55L 2.0, S81 3.0, TLS 1.0, PCT 1.0.
0., Add Goegle.com as a Wusted site:

1. 1. Open the Tools menu and select Internet Options.

2. 2. Orethe Security lab, ¢lick on Trusted Sites, then click on tte Sltes bulton.

0.3 Add the URL above lo the iist of busted sites.
FOR INTERNET EXPLORER (Mac DS X):

[.sClear your browser's cache:

1. 1. Open the Explorer menu and select Preferences.
2 2. Find the section labeled Web Browser and dlick on Advanced.
3. 3. Find the section labeled Cache ard dick on the Empty Now button. [Please nots, if you haven't recently cleared your fle

cache. it may take several minutes for this process to finish.)
0. Clear your browser's stored cookies:

1. 1. Open the Explorer menu and select Praferences.

2. 2. Find the Receiving Files section ard click on Cookies.

3. 3. Select 2l of the items that appear next to this section and dlick Delete.

.. Add Google.com as a trusied site:

1. 1. Open the Explorer menu and sefect Prefarences.

2. 2. Find the section labeled WebBrowser and click on SecurityZones.

3. 3. Find the drep-down menu labeled Zenes and select Trusted sites zone from the menu.
4. 4. Click tha Add Sites bulton,

5. 9. In the window which appears, click the Add buttan.

6. 6. Enter he following URL: hitps:fadwords.google.coms

0.7. Click OK.

FOR NETSCAPE:

.. Clear your browser's cache and cookies:

1. 1. In the Edit menu, select Praferences and elick on the Advanced drop-down menu.

2. 2. Select Cache and click on the Clear Gache button. {Please nate, if you have not recentiy cleared your file cache, it may take

several minudes for this piocess to finish.) Secondiy, in the Tools menu, select Cookie Manager and Manage Stored Cookles. Click on the Remove
AH Cookies button.
O.-Ensure that your browsar uses 128-bit encryption for secure connections:
1. 1. Open the Help menu and sefect About Netscape.
2 2. Verify that it supponts 128-bit security.
« Sel secuiily seltings:
[J 1. In the Edit menu, select Preferences and click on the Privacy & Security drop-gdown menu.
D.2. Select SSL and ensure that TLS, SSL Version 2 and SSL Version 3 are cheched, FOR MOZILLAFIREFOX {(Windows):
L1.. Clear your browser's cache:
1. Open the Teols > Options menu and select the Privacy tab.
2. Click the Clear bulton next lo Cache.
Clear your browser's cookies:
1. Open the Tools > Options menu and setect the Privacy tah.
2. Click the Clear button noxt lo Cookins.
Set security seltings:
1. Open the Tools > Oplions menu and select the Advancad tab.
2. Seroll ta the Security seclion and ensuse that SSL 2.0, SSL 3.0, and TLS 1.0 are all enabled,
Add adwords.google.com as a frusted site:
1. Open the Toois > Options menu and select the Privacy tab.
2. Click on the Cookies seclion and then on the Exceptions button.
. Enter hilp:#fadwords.goegle.com in the text field and elick the Allow button. FOR FIREFOX V. 1.0 (Mac 08 X):
Clear your browser's ¢ache and cookies:
1. Open the Firefox menu and select Preferonces.
2. Click on the Privacy lab.
3. Find the ine labeled Cache and click on the Clear hutten. (Please nole, if you have not recently cleared your fite cache, it
ytake several minutes for this process 1o finish )
4._Find ihe line labeted Cockies and click the Clear bution,
Set securly seltings:
1. In the Firefox menw, select Prefarences.
2. Click on the Advanced tab and find the Security section.
Ciick on the Triangle next to Security and verify that the checkboxes next to all of the following are checked: Use SS1. 2.0,
UseSSL:!D Use TL8 1.0
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i amounL What'swrong? - S :

Pteass try this troubleshooling checkiist of solutions to common fegin problems.

Corvect password? The password field is case sensklve, sa check to see if you are using the comeet capitafization, If you're unsure aboul of have
forgotien your password, you can choose a new one by dicking Forgot your password? on the AdWords home page.

Extra spaces in login? Qur login system is space sensilive as well as case sensitive, so be careful not to enter any extra spaces before or after
youriogin information.
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Correct emall addressT Make sure you're using the email address you proviced during the Googte AdWords account set-up process. Is it possible
you used an alternate addrass by mistake?

If you have a Google AdSense account, changes in your AdSense login inforration (email addiess and password) will also update your
Adwords logln information. If you have recenlly shanged your AdSense login information, please try logging in to AdWords with the updated
infosmation.

If you canlinue to have troubla Jogging in to your account, please contact us and provide as much delail as you can, Including any eror messages
you may be receiving.

Tragims pasmadsNortinets.

If you've forgoiten your cument password, you can reset the passwond for your account onling; lo protect everyone's security, we don't refrieve
or email passwords.

Here's how Lo reset your password:

1. Click Forgot your password? below Ihe login box on the Google AdWords home page.

2. This wilf take you to the Password Reset page. Enter your emait address to confinm your identity,

3. Click Enter.

. 4. Yourll be emailed a link that will allow you to temporarily access your AdWords account and to choose a new password.
Ptease nole that this link will only wosk ance; if you're still unable te log back into your account, you'll need to repeat the above steps.

FBN

Please nole, if you have a Google AdSense account that shares e curent login email address of your AGWords account, changmg your
AdWords login informalion will also update your AdSense login information.

“inhatif my Adwords icoiunt éoes ot (5dc i lalost Bant ransler?. -,

It can take 5-10 business days for Geogle te receive your transfor. The timing of a given transfer deponds on your local hank processes, so
Please ba patient, If we don't display your funds in your AdWords account after at least two weeks,

- Check that the transfer amount has been withdrawn from your bank account. If it hasn't, please check with your bank.
. . Please contact us. If the monay has baen withdrawn from your bank account. We may then ask you to send us the bank
statement that includes your bank transfer as a proof of payment. We'll then work with our third party payment processor to investigate.
- - Gonfirm with your bank that your money was seqnt fo the current receiving address that was providad in your payment
insinsclions.

fred a éredit 1o fiy.acqoune?

The AdWords Discounter reduces your actual cost-per-click {GPC) based on yair ad's clickthraugh rate {CTR).
From January 14th to February 17th, 2005, we incoreclly predicied the CTR for a small number of ads created
during this period; therefore, some ads didi't receive their fll discount. We've cormected the probtem and credited
the price dilferenca to alfacted advertisers’ accounis. You can see this credit as aline item on your AdWords
account Billing Summary page.

hutpsyfadswords,google.comisuer
Wiat 1 dm Autofivaticay logged out of my actount?

wsupportbin/index pyfulldump=1 {42 of 1 16)8/2/2005 §:3

The Google AuWords system is designed ta tog users oft after a seX period ofinactivity. It does this to both maximize the speed and efficiency
of the syslem
and to protect he security of Individual accounts.

There are severat possible salutions te this problem. You can reconfigure your proxy so that is does not use mullipe IP atdresses, use a different
praxy. or stop using a proxy setver to access the Intemet.

IFyou ave using the Intemnet Explorer browser and your session is expiring, please follow the instructions below.

1. With Intomat Explorer open, click Tools' on the top bar,

2, in the menu, choose "internet Options.

3. Click on the 'Connections' tab.

4. Click on the 'Settings® button.

4§, Glick the ‘Aadvanced button.

. 6. inthe box lited ‘exceptions,” under ‘Do not use proxy server for addresses beginning with type ‘hitps:* (without the single
quote marks). This should allow you to edid your AdWords account without sesslon expirations.

e

If this doas not wark, the firawall for your netwerk might be the problem. if you are using en HTTP proxy, and that proxy uses multiple 1P addresses
when connacting to external sites (like AdWords), then your session will expire every ima you access the site.
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What ] den sea iy ConverSion’

There may be several reasons why your conversions are not showing in your reports. Check Ihe following conditions:

[ Make sure that the conversion code has been placed on your website.
. Navigate to the cor fon confi page on your websita.
. Make sure that you can see the Google Sile Stals text on that page,
- Check that the conversion code Is on the correct page. Remember that you need to place the code on the conversion

conﬁrmahon page-when a user reachas this page, there should be no way te back out from the conversion. If you put it on a previous page, Google
may report conversions for users who leave your site before actually completing a conversion.

. Check again aker more time has elapsed. The reparts may not have been updated yet with your convarsion(s) - this can
bﬂfﬂBtImES take up te 24 hours.

Hoix do | restor iy campaipn fo

Cur performance monitor continuously reviews accounts; if we find 1hat your account has conlinued to experience poor perormance, we will notify you
via email. We will also slow the delivery of ads for your in trial keywards so that yeu don't have to pay for additional untargeled clicks that are unlikely
lo convent to sales. To restore full delivery, edit your ad and keyword list and dick the Restore Full Delivery button at the top of your campaign
summary pags.

Please note that the Goegle AdWerds automated perfermance monilor will conbinue to review the clickthrough rate (CTR) of your keywords, so
if your targeting improvements don't work out, you vill roceive another emall, If you need to restere full delivery a third ime, you will be charged
2 nominat reactivation fee. Leam more

vy vy o

Here are some common queskions and answers about stowing.

Whal is slowing? Slowing is our system'’s way of alerting you lo keywords which aren't performing well and which may be hampering your
campaign’s overall effectiveress. When our system determines that a keyword has a very fow dickttuough rate (or CTR), your ad witt begin to appear
only rarely on searches for those keywords. Youl see a message in your account lo alert you of this.

What's the point of sfowing? Slowing gives you the time to revise keywords so theyll perform better, of to Kentify and delete keywords that simply
arent reaching the audience you want. it also allows you to refine the text of Ihe ad{s) in the campaign to belter match your keywords. To read more
about how to improve keywords and ads for maximum performance, see the AdWords aptimization lips,

OK, I've revised my Keywords. What now? Once vou've revised or deleled any underperformiing keywords, and reviewed your ad lext, click the
Restore Full Delivery button on your Campalgn Management page. This Wil retutn your ¢campaign to normal delivery,

i your camnpalgn continues to perform poorly we will stow delivery agaln 1o give you more ime to re-edit your keywords and advertisements. A
nominal reactivation fee will be charged for every third time you restore full defivery in this manner.

Why do you charge a fee evary third timo 1 reactivate my account? Tha reactivation fee exists to encourage you lo optimize your
campaigns bafore restaring normal delivery. Gtherwise. advertisars might simply keep resloring rommal delivery with underperforming keywords
until those keywerds ara disablad, That results in a poor experience for them and for users.

| don't care how poorly my ad performs. Why don't you just let ma rin on every keyword | want? AdWords works best for everyone. users and
adverisers alike, when the ads are highly relevant to the kaywords of a search or of a given content page. Sfowing is a way fof us to alert you to ads
which aren’t highly relevant and probhably could be giving you belter resuts. Ullimately, underpedomning keywords will be completely disabled, so
slowing is a useful way to help advertisers improve keywards bafore they reach that point.

For mure on the topic of sluwing, please visit the Minimum CTR and Perfonmance Monitor page.

What 1 oot seutty covicsin trdng Lot

View the page sowce and make sure that yau see the conversion code on the page (marked with a < ! — Google conversion code —> comment tag).
To do this, sclect View > Source in your browser menu.

The Trarﬁc Eshmator tndudes samples af hlslunna[ ad perrnnnance (for your ads and other ads using similar Reywurds) ln its calcu!alions

I you see *<0.1"in the Clicks / Day field, the Traffic Gstmator has determined, based on this sampling, that your ad wil likely not gamer impressions
of receive clicks on any search results page or other ad space. Generally speaking, this occurs when the combination of vartous faclors such as your
maximum cosk-per-click {CPC) and clickthrough rate (CTR) aren't sufficient to eam an ad position.

In this situation, you may wish to Increase your CPG and improve your CTR until you reach your deslred resuils.
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ki wag g colean docined?

Generally, payments are declined if our billing system is unable lo verify the billing information you've
submitted. Here's a troubleshooting checklist of possible causes:

. Incorrect Credit Card Number;
Have you canceled the credit card we have on file for you and not yet entered your new credit card
information?

- Incorrect expiration date:
Please check the expiration date on your credit card. If your card expires, you must update your
AdWords hilling information when you receive a new card with a new expiration date.

- Incorrect billing address and phone number:
Be sure to keep your telephone number and billing address current. If the address and phone
number listed in your AdWords account do not match those associated with your credit card, our
systern will not be able to process your charges.

- Incorrect business information: Be sure you've selected your Primary Business Type
from one of the drop-down menus on the User Preferences page (under the My Account tab). Your billing
information will be considered incomplete unless you've made a selection,

. Credit limit reached:

You may-have reached your daily or total credit card limit on lhe day we allempted ta charge your
card. Your
credit card must have enough available credit to cover your monthly advertising budget. if your card
does not
have enough credit, you'll need to decrease your daily budget, or enter a new credit card with a
higher credit
limit. You may need to contact the issuing bank to determine the credit limits on your credit
card. You can update your billing information at any time. if you still cannot successfully submit your
cradit card Information, contact the card-issuing bank for details about why they have declined the
particular transaction,

&y g, buti ¢ant Seamy sits T tho sogrclyroBing

Gorgle AdWords advertising is separate from and unrelated to the ranking and Incluston of your site In Googie's search results. For more Informalion
about how websiles are listed in aur search results, please visit our Webmaster FAQ,

Whean you accass the Tralfic Estimator and analyze yowr keywords, you'll see, among other information, the
appioximate ad posilion and number of clicks you might receive each day. By simply increasing your meximum
cost-per-click (CPC), you can often improve your results. Howaver, you may encounter situations where
increasing your CPC has little effect on your estimates. This may occur for the following reasons:

Historlcal ad performance

The Traffic Estrmator includes samples of historical ad performance {for your ads and other ads using simitar
heywords) n its calculations. I the overall clickihrough eate (CTR) for this sampling is consistently low, youll

see lower click cstimates sefiected in the displayed estimates. In this situation, you may wish to improve your
CTR, which witl, in turn, Encrease your sstimates in the future.

Query analysis

In order te provide accurale traffic estinrates, the AdWords system monitors keyword and search query
palteris. Any low eslimales you racelve may be due to a lack of queries for your specific keyword or keyword
phrase.

In this situation, you may wish to try different keywords or keyword combinations. To do so, pleass access
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our keyward tool. (You can also gel ideas for additional keywords by clicking alternate keywords to the
fight ot your traliic estimates. )

Google Network policies

Search and content pariners on the Goegle Network have different policies goveming what types of ads may
appear on their pages or products. For example, some search and confent parners only accept family-safe ads.
The traffic estimator accounts for these policy variations among Google Network partness, and displays eslimates
accordingly. Therefore, while adveitising on the Google Netwark can Increase your exposure to new qualified
prospects, you may not necessarily see a significant change in traffic estimates.

Pyl

[dum l(ﬂufllﬁﬁ 22005 8:35:12 AM
B ymbol? |

The Traffic Estimator inchirdes samples of histerical ad performance (for your ads and other ads using similar keywords} in its caleulations.

H you see a - instead of a numeric value in the Position field, the Traffic Estimator has determined, based on this sampling, that your ad will likely not
gamer impressions on any search results page or other ad space. Generally speaking, this accurs when the combination of various lactors such as
your maximum cost-pesr-¢lick (CPG) and dlickthrough rate (CTR} aren't sufficient to eam an ad position.

In this siluation, you may wish to inciease your CPG and improve your CTR untll you reach your desked results.

If your web browser blocks cookies from Google.com, you may experience difficulty staying logged in to your Google AdWords account. To allow
cookies from Google, foffow the instructions below:

In Intemet Exploret:
1. Click on the Teols menu and selost Internct Dptlons.

1.
2. 2. In the resulting dialog box, select the Privacy tab and click on the Edit butten near the bottom of lhe window.
3. 3. In the fleld I1sbeled Address of Web site enter ‘gocgle.com’ (without the quotes).

0.4. Click ke Allow button followed by OK uniil you retum to the main b window. ln N

1. . Click on the Tools menu, seloct Cookle Manager and ‘Manags Slored Gookies.”

2. 2. Click one lhe Cookie Sites tab.

3. 3. Inthe field labeled Manage sites that can... enler ‘google.com’ (wilhout the quotes).

0.4. Click on the Allew bution followed by Close 1o return to the maln browser window, tn Mozilla FlreFox:
1. Glick on the Tools menu and sefect Options.

2. 2. Click on the Privacy con snd sefect Cooldes.

3. 3. Click on ths Exceptions button.

4. 4. Iniha feld Yabeled Address of wehsite enter ‘google com' without the quotes.

5 5. Click on the Altow bution followed by OK until you retur to the maén browser window.

Recent changes to the AdWords keyword evalualion pracess may affect reports you created pravicusly in your Reporl Center. The keyword stales
'strong,” ‘moderate,’ "at risk,' and 'slowed’ were phased oul as part of our ongoing efforts to streamiine our keyword evaluation process and help our
users find exaclly what they're looking for,

Because of this change, some older scheduled and on-dernand reports will no longer retum accurate results, For example, if your regularly-scheduled
report included "al risk’ keywords as a parameter, (hal report won't run properly because "atsisk’ keywords no lenger exist,

Here's how 10 see which of your reporis may have been affected:

1. Log in to your AdWords account,
2. Glick the Reports tab at the top of the page.
3. Click Download Center on the Reports tab.

WN

Any reports affectad by this change will be marked vith a notification alert at the top of the page. We recommend that you create entirely new reports
based

on the new keyword stales, and deleta the affected reports.
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To ¢reate a new report:

1. 1. Fram the Download Center, click Create Report on the Reports tab at tho top of the page.

2. 2. Select a reporl Typa from one of the options to e left. chick the fink, and folow the instructions to create your new report. We apologize
for any inconvenience this may have caused.

Holpiul Links

» MOre o npors.
= MOT€ o yroimmursor vauesa
+ BAOTE oot i - et v

y weEounE o th ekt X in Vb folbming envai:

=1l you request data for a ime period that goes beyond three months prior to taday's data.
-ifno changes were made to your account for the time period that you selecled. We're working to make
more informalion available to you, and we appreclate your patience In the meantime.

hitps:ffadwords.google o

The feature you're lrying to access is temporatily unavailable due {0 routine system maintenance. We expect to complete this maintenance within 24
hours. Please check hack at that time.

We apologize for any inconvenience this may cause.

My ads are live--now what? : Troubleshooting my account : Troubleshooting my ads

The Ads Diagnostic Tool can report the ad position for active keyword-targeted ads, and identify why a partiular ad or group of ads may not be
showing. In those cases where an ad is not shown, this tool provides recommended sleps o help you gel your ads up and running.

You can access the teot via Lhe foXowing sleps:

1. Log inte your AdWords account.

2. Click Tools beneath the Campalgr Management tab.
3. Cick Ads Diagnostic Tool.

4. Enter information for elther Option 1 or Oplion 2:

Ealiad a

Option 1: Search Terms and Parameters

Use this option if you're concemed abott all ads within your accoeunt that should be appearing for a specific search tenm. Spacily the
keywaord query, the Google domain, the disptay language, safe search selting, and user location.

Option 2: Search Resulls Page URL

Use this option if you're concemed about a particular search resulls page that you believe should be showing one of your ads. Copy and
paste the URL from lhe address bar on the search resulis page where your ad should be showing.

5. Click Confinue when you are finished. Site-targeted ads can't be diagnosed with this tool at thia time.
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The Disapproved Ads tool within your AdWords account allows yout to easily check the stafus of your disapproved ads and find out why they were
disapproved. You'l stil receive emaits fronm our AdWords Specialists regarding all disapproved ads; however, this too! will also be avatahle for you to
review your ad disapproval stalus at any kme.

With this tood, you'll be able to review the ad. its location, the reasen for disapproval, suggestions from our AdWords Specialists, and the date your
ad was disapproved. At this time. the tool does nol refiect the stalus of approved or pending ads, or keywords for you aceount.

To access e Disapprovad Ads too), please do the following:

1. Log into your AdWords account.

2. Click Tools’ on the Campaign Management tab.

3. Click Disapproved Ads under the Anaryze Your Ad Performance section.

4. To edil an ad, click the Edit ad link in the far righthand calumn, You'll be able to edit your ad from its coresponding Ad Group; once
you save your ad, it will automalically be submlited for review by our AdWords Specialists.

AwR e

Tips:
-Glick Details in the Disapproval Reason eclumn to leam mare about why your ad was disapproved.

- Ifyour ad belongs to a paused or deleted campaign or Ad Group, this status will be included in the Carmpaign or Ad Group columns. I this case, you
won't be able to make edits. However, you can dlick View ad’ to review the ad text.

-Taremove ads from this page (but not actually remove themn fiem your account), use the Ignore function at the top of the table. You can aiso use the
drep-down box [0 view disapproved ads for: Show aff campalgns, Shaw only aciive campaigns, Show all bit defeted campalgns.

1. Check your ads. They must adhere to our Editorial Guidelines. Ads will not run on the
Google Network unlil they've been reviewed by our AdWords Specialists, so please ensure that you meet
the standards in the

Editorial Guidelines. You may notice your ads appearing on Guogle before they appear on AOL or
other network sites because of this review process. To learn how to edit your ads, click hare.
2. 2. Increase your daily budget. If your ads qualify for the Google Network, you can expect
more people to see your ads and more clicks to come your way. Make sure that you get the exposure you
want by increasing your .

hups:fadwaocds gopgle,com/suppori/bi pyTfulldump=1 (46 of L16)B/2/2005 8:35:12 AM.
daily budget. lncreasmg your daily budget maximizes the number of impressions your ads receive. To
learn how to increasa your daily budget, click here,
1. 3 Increase your maximum cost-per-click {CPC). The posilion of your keyward-targeted
ads is delermined by various performance factors including: maximum cost-per-click {CPC), clickthrough
rate (CTR), and ad text. You may wanl to increase your CPClohelpi improve your ad's position. AOL only
displays the top three Google AdWords ads on any given page, so raising your CPC increases your chance
of consistently appearing on all advertising network sites. To learn how to increase your CPC, click here.
2. 4, Increase your clickthrough rate {CTR). As mentioned above, your ad's posilion is partly
determined by your CTR, so be sure your ads are optlmlzed and ranked high enough to appear on AQL.
You can increase your CTR by refining your ad text, using keyword matching aptions, and using the
keyword tocl to refine your keywords. To learn more about how to increase your CTR, visit our Optimization
Tips page. You can also learn how to proactively monitor your keywords.
3 5. Increase your maximum CPM. If you're running site-targeted campaigns with cost-per-
impression (CPM)} pricing, increasing your maximum CPM should increase your visibility on the Google
Network. To leam how to increase your CPM, click here.

4, 8, Check your distribution preference. Make sure you haven't already opted out of the
Google Network. To fearn how, click here.
5. T Finally, some Google Network partners may restrict advertising based on thelr own

policies regarding content. As a result, one or more of your ads may not appear on these sites.

The suggestions supplied by the Ads Diagnostic Teol were compifed based oa our ongoeing support experlence with advertisers within the program.
While these recommendations are genesally applicable lo alt advertisers, we understand that you may still exparience some difficely getting your ad
up and running after folowing thesse suggestions,
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Please conlacl our suppont team and we'll be happy to assist you with your account. In your message, please include a list of the ad{s) and keywords
you are concerned about, and include the campalgn name and Ad Group where eachis lecated. An AdWords Specialis! will research your eoncem(s)
and conlact you with reasons and solutions for your particular case.

The Ad Diagnostics tool reviews data spacific to each guery and its related ad(s) based on all available account data at the ime you run the ad
diagnostics report. Like the statistics available for your campaigns and Ad Groups, reporting is not real-time and may not reflect data received in the
Tast three hours. Piease note that using this toot will not generale additional impressions for your ads.

IFthere are other faclors within your account affecilng the query and ad diagnosed, this Information will be Included in the diagnostic resulls, Details
that may impact your ad delivery for a particular query will only be Included from active campaigns. Ad Groups, and keywords. Cumentiy, the data
reviewed is specifiv only {o those ads you have targeted to the Google search netwark.

Reported issues for a particular ad and its refated keywords may include any aspect related to ad creation and your account settings. Examples
include ad and keyword approval status, cost-per-click (CPC) and budget price settings, ad and keyword pedormance, fanking status, geo-targeting
seftings, ete.

Wy b2t d 868 .

Sometimes we're unable to obtain intemel pratocol (IP) informatior for some searchers, especially those using intemet service providers (ISPs) that
empioy proxy servers. Because we can't determine Ihe searcher's jocalion in these cases, well show nationally-targeted ads instead of regionally-
targeted ads.

AdWords billing & payments

You assign a maximum cost-per-dick (CPC) for each Ad Group and/or keyword in your AdWords account. Simitar
to bidding in an auction, the maximum CPC you enter should be the most you are willing to pay per dick. Likely,
you'll pay less-we adjust your price per cfick based on your nearest competitors. Tha lowest amount you could bid
and pay within the AdWords pricing madel is the minimum CPC, which varies based on the country in which your
ad is shown. To leam more about the minimum CPC in your target localion, visit our form of payment finder.

There are tvio possible minimum CPC amounts:

Globat Minimum EPC: The minimum CPC required to potentially show your ads in alt AdWords target
counfries. The minimum CPC may be lewer in certain locations {local minfmum CPC).

Lotal Minimum CPC: A reduced, lccation-specific minimum CPC for ads targeting China and Poland, and for
advertisers with billing addresses in China or Poland. Only these adverkisers can enter the local minimum CPC
as {he maximum CPC for an Ad Group.

Keep b mind that selecting the local minimem CPC as your maximum CPG may prevent your ads fom
showing in all of your chosen target countries. To show your ads in countries other than China and Poland
you must bid at leas! the globat mielmum CPC.

https:Hadwords. google.comisupportbinfindesx pyfulld | {47 of 16)8/2/2005 8:35:12 AM
As always, the AdWords Discounter wiil aulomatically adjust your CPC to the minimum amount needed to maintain your ad's position. That means,
based on the locaticn of your customer, you may still pay as iittle as US$0.02 to show your ad.

Here's an example of how these two minimum CPC values work:

Your billing address is in China, and you set up a campalgn that targats China. Because China has a local minimum CPC, you can anter bids as low
as USD $.02 per click. Suppose you then change the country targeting of your campaign to include ihe Unitad States. To target the US, you will need
to bid at least LUSD$.05 in order for your ads to show. It is still possible that you will pay as littie as USD$.02 per click fram users lecated in China
because the AdWords Discounter will automatically adjust your GPC basad on the tocation of the user,
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AdWords billing & payments : My billing address is in the European Union

T AT oo

Yes. As of July 1, 2003, all AdWords accounts with European Union (EU) business addresses became
subject 1o Value Added Tax (VAT) charges. In addition, as of January 22, 2004, all EU advertisers moved
from being an-advertiser with Google Inc. (United States headquarters) to heing serviced and billed by
Google Iretand Lid {EU).

Advenrtisers with a business address in the EU, but outside of Irefand, may self-assess VAT at their Member
State's local rate if they are using Google AdWords for business purposes.

ol ¥ rauids G oiple with a Valid VAY il

New adverlisers are asked to provide VAT information during the account set-up process. If you're a current
advertiser and already registered for VAT in an EU Member State, please follow ihe steps below 10 update
your VAT information:

.Log in te your AdWords account,

.Select the My Account tab.

.Click Billing Preferences (located just below the tabs).
Locate 'VAT Information' and click Edit.

.Fill out the fields in the VAT Information section.
.Click Save Changes.

Online Advertisers: irish Biiling Addresses

Geogle Ireland Ltd. charges your account at the current Irish VAT rate, so you do not need to self-assess
your VAT charges. Please note that the lrish VAT rale is subject to change per the Irish government's
discretion.

If you do not provide Google with a valid VAT registralion number, Google will stlll charge your account,
including the initial activation fee, at the current lrish VAT rate. Piease note thal the lrish VAT rate is subject
to change per the kish government's discretion.

Online Advertisers: EU Billing Addresses (Outside of Ireland)

If you use Google AdWords for business purposes and have an EU business address outside of Ireland, you
may self-assess your VAT charges at your EU member country rate. Google will not add VAT to your cosls if
you declare that you use Googie AdWords for business purposes, and your business address is in the EU
but outside of Ireland. You can learmn more about EU VAT registralion al: http://feuropa.eu.in/

If you do not declare that you use Google AdWords for business purposes, Google will charge your
account, including the initial activation fee, at the current lrish VAT rate instead of your EU Member State's
rate in accerdance with lrish VAT regulations. Please note that the lrish VAT rate is subject to change per
the Irish government's discretion.

We undersland that onfine ransactions require trust. In particular, we take billing and credit card security very
serousty. If you have refund or credil requests
or concems about your aceount charges, whether they're related to security issues or not, please let us know.
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However, because email is not a secure means of communication, please do not email us your credit card
vurmber of aceount password. We should be able to resolve the issue without his information. Please do provide
us with your account’s email address and as much other information as possible regarding the matter. An
AdWords Speclalist will review your email and work te reach a solulion as quickly as possible.

If you contact us with a biling concern, we may tamporarly suspend your ads so you don't accrue further
charges. We may also suspend your ads if wa have trouble processing charges for your account.

in order to reactivale the account, we ask that you please re-submit or update your payment information
in otder 1o pracess your charge. Once we've processed your paymenl, your campaigns wilk
awtomatically be re-enabled.

hipsHadwords.google com'supporibinfindcx pyMalldump=t (48 of { 16)872/2005 8:35:12 AM
Refunds (if any) are at the discretion of Google and only I the form of advertising credit on www.goaple.com. Please contact your credit card
issurer for information on additional rghts granted to you as pant of your cardholder agreement.

For technical questions about VAT registration in EU Member States or VAT reimbursements you should
consult your tax adviser.

For general questions about how VAT affects your Google AdWords account, you can Contact us.

AdWords billing & payments . AdWords account costs

With cost-per-click advertising on AdWords, the cost of your campaigns really depends on you — how
much you are willing to pay and how well you know your audience. It all boils down to knowing your own
goals and lefting us know what they are.

. Set your own limits: There is a nominal activation fee for Google AdWords. After that,
you tell us how much you are wilting to pay per click and per day. Please click here for more information on
selecting your CPC and daily budget.

- Start smart: Don't bid more than you can afford. if you are unsure what to pay per click to
acqu:re a new customer, we help you by giving you cost estimates, specific 1o your campaign settings,
during the sign up process.

. Graw from what works: Once you know what works, you ¢an start to build more
campalgns and Ad Groups 1o altract your potential customers. In addition, keyword-targeted ads eam their
position based on various performance factors including: maximum cost-per-click (CPC), clickthrough rate
(CTR), and ad text. With a strong performance history, you ¢ould end up paying less to maintain the position
of your ads.

. Pay less for more results: Keep in mind that because of our AdWords Discounter and
dynamlc ranking system based on various factors such as CTR, CPC, and ad text, your actual cost-per-click
{what you actually pay per click) is often tess than your maximum CPC {whal you are willing to spend per
click) and often decreases when your ad starls to perform better.

In addition to daily budget, maximum cost-per-click (CPC), and performance, which directly control
your costs, keywords and targeling are important factors to consider.

Keywords: We suggest you start off with just a small list of strong keywords and a few
dnfferenl targeted ads. This will help save you money by reducing the number of untargeted clicks, which are
unlikely to convert to sales. Using keyword matching options also helps you manage your costs by limiting
your ads to the most relevant searches and content pages.

. Targeting: Your CPC is based on what your nearest competitors are willing to pay, so
largeung your ads to your specific market ensures that you are competing in the right market and paying
only what you need to pay. Effeclive targeting is accomplished through keywords, ad text, and language and
country targeting seltings.
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How o inctepsathe cally bl 1

To increase the daily budget for an ad campaign:

Log in to your AdWords account,

In the Campaign-Summary table, select the checkbox{es) next to the campaign{s) you wish lo edit.

Click Edit Settings in the header row of the lable.

Enter the new curency amount(s} in the Daily Budget fietd(s) on the left side of the Edit Campaign Settings page.
Click Save All Changes at the {op or betom of the page.

Note: Your daily budget applies to individual campaigns, not your total advertising spend. For example, if you have three ad campaigns, each wilh
US$5.00 daily budgets, your maximum daily adveilising spend would be US$15.00.

How o 1.getimy ad i the 10 s

Google believes strongly in providing high quality and relevant adverfising lo our users, so Google AdWords does
aiot rank ads solely on cost. Thore is no way o Feservo top placement in the AdWords progran.

hllpﬁ:lhdwnrds.gobglc&mfsuppoﬂfbhfmdmpy?ml]dumfI (49 of 1 16)872/2005 8:35:12 AM
Ad placement is based on a combinatfon of various factors such as your maximum cost-per-click (CPC — how much you are willing to pay per dick),
clickthrough rate [CTR — ralio of clicks to how many limes your ad was seen), and your ad text, This means that if you eam a higher CTR with better

quality ads, you can be rewarded with a lower acteal CPC. Our sysiem monitors your gompelition and perfc and icafly charges you the
teast.amount possible.

Yows ads begin ruaning and accning costs only after you activate your account. When you are ready to activate your account, log In 1o your atsount
and submit your billing Informalion. Your ads will then appear on Google almost immediately. You'¥ only be billed after one month or after you reach
your first AdWords eredit limil.

Choosing a maximum cost-per-click

The pre-filied amount highlighted in blue is our recommended maximum cost per click {CPC). Matching this
amount ensures maximum ad exposure and clicks for all of your keywords. Once you have decided on a
‘maximum CPC, click 'Calculate Estimales.’

ratym £ost ar—élick—

Assess your cost, click, and position estimates

The Traffic Estimator returns estimates of how much you might pay per day for the keywords you have
chosen, In this example, the average cost per day is US$16.14 with an average CPC of US$1.62. You'il also
see the average position of your ad, Here, the average position is 1.5.
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Chdose cunsncy aﬂd maxlmum cost'psr—circk

You may decide that the Traffic Estimator predicted too many or 100 few clicks at oo high or low a CPC. if
s0, you can enter a new maximum CPC in the maximum CPC field and click 'Recaicuiate Estimates.”

You'll now see a new list of estimates. In this example, lowering the maximum CPC to US$1.50 from
US$2.41 resulted in an average CPGC that was, on average, US$0.86 lower. Howaver, the average position
dropped from 1.5 fo 2.3 and the average clicks per day dropped as well.

if cost is more important to you, you may choose o go with this recalculated oplion. if position and
exposure are more important, you may {ry option 1,

Chooze cumbw ane! maxlmum cost-per-c!lck -

You can cancel your Google AdWords account at any ime by pausing or deleling alt Ad Groups {or campaigns)
vilhin your accounk, Or emaif the AdWords
staft using our coatact us form. We'l procass your raguest and send you a confirmation email.

Once you cancel, your ads will stop running and no new charges will accrue to your account, However, we will process any pending charges
generated between your fast biling and the date your cancellation request was processed. As a resull, you may see charges appear on your Billing
Summary page afier you cancel. Because our bifling cycle is 30 days, you may nat b billest Ioz these final charges untl a few weeks after you cance.

Youll be able fo reactivale your account sastty at any lime in the future. To do so, just log back into your account and foliow the prompts to re-
establish your AdWords advedising senvice.

With Google AdWords cost-per-click {CPC) pricing, you pay only when someone clicks on your ad. Click here for mose information about sources of
legitmate clicks.

If you suspect that your ads have been affected by rwalid dlicks, dick here to leam more aboul AdWords click quatity.

We recommend daily budgets based on héstorical dala for the same or similar keywords as you. We slso consider additional factors-such as varialions
inlanguage and location and Google Network activity.

The daRly budget we recommend will ensure your ads appesr for all relevant searches, increasing your visibility and reach to potential customers.

Remember, setting your daily buxige? lo the amount we recommend Is oplicnal-you're ahways in full controf of your AdWords acecount. You can edit
your campaign's daily budgat as often as you'd like, and 1o whatever amount results in the mest appropriate refum on investment for you,
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'ﬂ,u[ﬂloGooglsNe_lwoﬂ(sﬂas? i Tl

There is no fee to run your ads on sites and products in the Google Netwark. Ad distribulion is 2n added benefit of the Google AdWords program.
and your ads are autematically eligible.

As wilh all Google advertising, you only pay for dicks on your ads. You control how much you spend by selecting a maximum cost-per-click (CPC)
and daily budget that it your advertising goals. For more information ot AGWasds pricing and billing, please click here.

Because ads largeled to content pages are based on the same set of keywords ag used in search, the same maximum CPC that you set for your ads
also appltes for ranking your ads on content pages. Although the average CPC that you pay for contextual advertising may differ from search
depanding on your competition, you only pay for elicks that you recelve, and you will never pay mose than your maximun cost per click.

Gougle shows your ads evenly over ime 50 thal you reach your daily budget by Ihe end of each day. This keeps your ad from accumulating charges
early on and then disappearing for the remainder of the day.

Once you've selected your keywords, you'll see a recommended daity hudgel. If you sel your daily budged ko tis value. you will maximize your ad's
visibility and activity. f your daily budget is lower than the recommended amount, Google will deliver your ais eventy throughout the day lo keep
your costs at or below your daily budget. Click here to leam how to view and cdit your daily budgat,

fy keyvidid?

No. With Googla AdWords, you dan't have to worry about this. You ¢an simply sel the same maximum CPC for alf your keywords, knowing that the
AdWords Discounter will chargs you the lowest CPC you can be charged while still maintaining your posltion for each keyword. If you want lo assign
different CPC values to different keywords, you can simply set up separate Ad Groups with different maximum CPC amounts. You can alse use our
power pasting feature

to assign a different CPC to cach of the keywords within an Ad Group.

Other advertising programs rexjuire customers to specify a set price lor each keyword. This maeans their customers not only spend more money than
necessary, but also must invest a significant amount of time patrolling their keywords in order to reduce costs. For exampls, if you had set a cost-
par-click (CPC)'of US$0.91 In order to appeat in the tap spot, and the advertiser in the secend position reduced his or her price from US$0.00 to
US$0.70, you would be paying US$0.20 more than necessary to maintain your position,

At this ime, the direct debil payment option is only avaltable lo AdWords advertisers with bank aceounts in centain countries. When you select this
payment method, you duihorize Goegle, Inc. and/or Its affiliates and thefr rep ive bank or pay pri 10 submil appropriate charges to
your bank for deduction from your bank account for services rendered via your Google AdWords accowmt. Google may submit charges without specific
rotification or confirmation In advance of the ¢harge request.

If you have any other payment concerns, please Conlact us. One of our client service specialists would be happy 1o answer your questions.

i haccessibie? |

Googla AdWords is designed to give you the power 1o menage all aspects of your accovnt for maximum
performance. Becavse all accaunts are self-managed, itis our advertisers' responsibility to ensure that the
destination URL in each ad is accurate. Also, if an adverliser's website is unavaitable, the advertiser is free fa
pause o delete any campaigns for that site.

hitpszifadwards.google com/supportbinfindex.pytiulldump=l (51 of H16}872/2005 8:35:12 AM
By agreeing to participate in the AdWords program, an advertiser provides authosization for charges. You can view the AdWords Terms and
Cenditions for more information.

No. Image ads pricing Is the same as text ads pricing. For keyword-targeted ads you may choose a
maximum cost per click (CPC) of from US$0.05 to L/5$100.00. For site-targeted ads you may choose a
maximum cost per thousand impressions (CPM) of fram US$2.00 to US$100.00. Your dally budget can go
as high as you like. You may change your amounts within these ranges at any time, and there's no minimum
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spending commitment.

Coférican Fchaage my oy bukan? .-

Over the ¢ourse of 2 single day, you may change your daily budger for each campaign in yeur account a maximom of len imes, Pleasa note that we

reserve the right 1o exercise our discretion regarding excassive changes to dally budgets.

Haw dot Sek émonhly budget? e

W you created your AdWords ads yoursell, you were asked 1o set a dally budge! when you signed up. To alter yowr monthly spending, follow the steps
listed below to reset that daily number.

If you used Jumpstart lo create your AdWords campaign, you were asked lo specify a monibly budget. The Jumpstant team divided that numbsr by
30 to determina your daily budget. To change your menibly spending, just revise the daily budgel number using the steps below.

1. Log in to your AdWords account.

2. Click the nama of the campaign you wish to rebudget.
3. Click Edit Campalgn Settings.

4. Set your new daily budget.

5. Click Save All Changes.

PP

For more details, see How do | choose my daily budget?

“Doos &mait piring eppY t0image ads?-

Yes. Remember, image ads are priced, targeted, and ranked in the sama manner as AdWords lext ads.

AdWords billing & payments : Payment options

“Wliak are my payarienl options? -

Google AdWords currenfly accepls major intemnatianal credit cards, debit cards, direct debit, and bank transfer payments. Payment oplions available
depend on your counlry and cuirency. Visit our payment options page 1o view all options currently oKered.

Please note that the most widely available method of payment is by credit card, such as MasterGard and Visa, accepted internationally, and debit
cards. In centain countries where credit cards are not widely used, we also offer direct debit and bank transfer payment methods. Bepending on the
payment method that suis your locale, you may also have the opfion to pay for your adverlising prior lo receiving clicks or impressions {prepay) or
afterwards {post-pay).

=Past-pay allows you to pay only after you accrue charges. You ads run alinost nmediately after you submit your biling information.
When you

activate your post-pay AdWerds account by submitting your billing Information, your ads start rimning. You are then given an initial credit
fiit ihat allows your actount to run hefore you pay for any of the activity your ads receive. You are than charged every 30 days or afler reaching your
cradit limit, whichever comes first. If you reach the credit imit within 3¢ days, we will charge you and raise your credit limit.
. . Prepay allows you to pay in advance of recelving any activity. As you accrue advertising charges, we deduct the cost from
your prepald balance. Your ads run aimost immediately after we receive your payment. I your account runs out of funids, your ads will stop running
until you make another payment, so ba sure te regulary check your account batance. To help you keep your ascount balance up-to-dale, we'll emall
you when your funds run low and when your balance draws down to zero.

To make a payment, please follow these steps:

. 1. Log in to your AdWords actount.

2. 2. Click "Make Payments’ under the "My Account’ tab,

3 3. Enter the amount of money you would like to pay into your AdWords account.

4. 4. Click the "Go' button to generate a one-time reference number and transfer information form with al of the important
informatien you'll need Lo initiate a bank transfes.

5. 5. Print or copy down the reference number and additional ransfer information provided,

6. 6. Use the transfer information to initiate a bank transfer from your counlry. Please e sure o indlude your reference number,
Wo will nof be able to process your paymen! without the reference number.

7 7 When we receive the funds and reference number, we'¥ send you an emali and your ads start running {or continue running it

you are refres-hlng your prepay halance},
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Figase nole that # may lake up lo len business days for the funds to reach your AdWord's account.

hﬂps—_l.'adwo:dsgong]e
erdo! makpapayment?

PP

infindex py?fulldumps1 (32 of | 16I&//2005 B:35:1ZAM

When you sign up Tor AdWords, your account will be structured so that most payments happen automatically via credil or debit card.

Google AdWords currently accepts major international cradit cards, debit cards, direct debil, and bank transfer paymen:s Available payment options
depend on your country arcf cummricy. It you do choose a prepayment option {such as bank ansfer or, in G y, Bankeinzug), you will need lo
make paymenls. See Howt do | make a bank transfer payment? for mora informalion.

To leam more about all forms of payment, see What are my payment oplions?

titeré & nidinium pr'gfpaymei'll'h"nff'o:uhl'? -

¥es. For the amount in your currency, please visit our payment options page.

45301 Seh . cLrénicy o paytent options ofté Setting up Ty secoimte < 2. o

Once you set up your account and select the currency in which you'd like to be billed, it is not possible to
switch to another currency. Please note that the currency you select applies to both billing and payment.
That is, if you select US dollars, payment will be requested and accepted only in U.S. dollars. If you would
like to change currencies, you will need to close your existing account, and creale a new account with your
preferred currency. It is important that you close your initial account to remain in compliance with AdWords
Terms and Conditions.

To improve the overall AdWords billing experience, we're upgrading AdWords accounts to a new billing
system over the next few months. As a result of these upgrades, post-pay adverlisers may swilch back and
forth between available forms of payment {Master Card to Visa, for example). Please visit:
https:ffadwords.google.comfselecl! AfpoFinder to view your options.

We look forward to providing you with more payment change oplions in the future.

Haw dok ivosshe be:);fmén_l method ats right farme? - =7 -

First, be sure o review all available payment aptions. In an effort to accommodate all potential advertisers,
we provide as many oplions as possible. Once you know what is available to you, you can decide what
makes sense for you.

Here are facts to consider when making your decision:

0. if you prepay for your account...
. Your ads don't start until we receive your first payment. it may take a couple of weeks for
us lo receive your payment if you prepay by bank transfer.
. We'll stop running your ads if you run out of funds.
D.. If you sign up for post-pay...
. Your ads will start running on Google almost immediately
. We'll stop running your ads if we can't process your payment. Remember to keep your

payment information yp-to-date.

Post-pay advertisers may switch back and forth between available forms of payment
(Mastar Card to Visa, for example}. Please visit: hitps:/fadwords.google.com/select/AfpoFinder to view your
oplions.
. - it isn't possibie to change from bank transfer to credit card, or vice versa.
. Always send the payment reference number with your fund transfer. This number is
the only way we can associale your payment with your account. if you iransfer money fo us without including
the reference number, there Is no guarantee that we will be able to apply the funds to your AdWords
account. You musl generate a new reference number for each payment you make. If your bank transfer form
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does not have a field for a reference number, please enter the number in front of or instead of your name.
Google may not be associated with the name of the bank account to which you are

requested to send your money. Google has partnered with a trusted third party to process bank transfers.
Bank transfer is not a universally available payment method nor is there a

standardlzed procedure for all banks. Even banks within the same country may have different procedures

for Initiating a bank transfer payment.

. . Your bank may charge you a processing fee, which will be in addition to the amount

you send Google.

Wit o1 nedito kndvi bt binitraisfer?:

hnps:#adwords, google.com/supportbin/index py? fulldump=1 (53 of 116)3/2/2005 §:35:12 AM
Googfe does not reimburse advertisers for any bank-imposed processing fees. If your bank imposes a fee
or is unable to complete the transaction, another local bank may be able to provide more suitable options.

. it can take 5-10 business days for Google to receive your fransfer. The timing of a
glven transfer depends on your focal bank processes.
. Check your prepaid account balance regularly to make sure that you don't run out of

funds Make more payments as needed. When your Google AdWords prepayment balance is running low
{approximately 7-10 days worth of funds remaining), we'll email you to give you a heads up to make an
additional payment. it's possible that your account wiif run out of funds sooner than 7-10 days from the time
we email you, depending on your ads’ activity. If your balance hits zero before your payment reaches us, our
system automatically stops showing your ads until you make another payment.

Daos Googlo AtWoids offar et

Some adveriisers may have the option for billing based on credit terms and monthly invoicing. Typically,
these advertisers will have an established payment history for at least three months with the Google
AdWords program, and meset our minimum requirements which vary by country.

In order to provide credit terms and monthly invoicing, you must first submit a credit application for review
and approval by Google. In some cases, our finance team will request additional financial documentation
from you for further consideration. Sheuld Google approve and offer you the billing option of credit terms,
you will then need 1o respond to the email in which you are offered our credit terms billing option. Credit
terms are determined at Google's sole discretion. Once you respond to accep! the credit terms offered,
your account will then be swilched from credit card billing to credit terms within 48 hours.

Please note that with the credit terms option, you agree to pay the full balance of your account upon receipt
of each monthly invoice. Under these terms, Google reserves the right to suspend or close down your
AdWords account if the following occurs: Google does not receive your payment within 15 business days of
the monthly invoice date, and/or you exceed your monthly credit iimit, If Google has reason to believe thal
you cannot continue to meet your financial obligations under credit ferms, Googla has the righ! to cancel
your parficipation under this billing option. Once you are approved for a maximum credit limit per month, you
are responsible for paying Google up to this maximum credit fimit should you spend that amount on
advertising. Finally, you are solely responsible for malntaining your AdWords program accounts, daily
budgets, and daily spend levels.

If  have & Pispay:accoiint i

You can request a full refund of your remaining prepaid balance contacting AdWords Support. Once we
receive your refund request, we will stop running your ads and email you a confirmation that we have
begun processing your refund,

Because our reperts are not real-time, there may be outstanding advertising charges that have not yet
shown up in your reports at the time of your refund request. We will deduct these charges from your
account balance before processing your refund.
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Once your refund is processed, your AdWords account balance is set to zero, and alf remaining funds in
your AdWords account are refunded to your bank account, We will send you an email when the refund has
been processed and fet you know the final refund amount after deducting any outstanding costs for
advertising activity. After the refund appears in your AdWords aceount, you can make another payment at
any time should you choose reactivate your account.

if you are having difficulties wilh AdWords, you can pause your campaigns on your own and contact us. We
are more than happy to work with you to help you resolve your problems without clasing your account. You
are important fo us, and we slive to insure that your experience wilh AdWords is a positive one. We value
your feedback and would appreciate any suggestions you have for us.

Is Ihora:a spendmgmmrmlmnﬂlwwa[ymgprdwsis

There is never a minimum spending commitment to run AdWords ads. There is an
activation fee for all AdWords accounts, and prepay has a minimum payment
limit. Beyond that, you have compiete control aver the maximum you want to
spend per click or impression, and per day. This s the same no matter how you
choose 1o pay for your advertising. You don't need to pre-qualify. You have the
freedom to decide if you want to choose prepay or post-pay for your AdWaords
aeccount. For more details on payment options and associated costs, please visit
our payment
3 options page.
‘Hawgtan.T erisire tiat Gogle 16tevas iy bak wash

To ensure that Google successfully receives your bank transfer payments, we recommaend that you
follow these guidelines:

Payment reference numbers

. In some countries, a bank may ask you to fill out a form to initiate your bank transfer
payment Please write the payment reference number on this form. If there is no field in which to include this
number, simply write the number i front of your name on the form.

. When sending a payment to Google, please use only one unique payment reference
number per payment. For muitiple payments, you must use a different payment reference numbar for each
payment.

- Include the unique payment reference number provided by Google along with your payment.
if you are using a bank to send your payment, make sure that the bank includes this
payment reference number along with the payment.

Banks ard bank transfers

. Due to the way the local banking networks are set up in some countries, you may
experlence fimited coverage. This means that not afl banks will be able to send a bank transfer payment to
the Google-specified bank account in your country. You may need {o contact several banks before finding
one that can send a bank transfer payment.

. Please note that the exaci procedure for initiating bank transfers may differ depending on
your country. Even within the same country, different banks may use different procedures for initiating bank
transfers.

Please note thal most bank transfers are 5-10 days on their way to Google.
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AdWords does not accepl online payment processors like PayPat at this time. We gladly accept several
credit and debit cards and, where available, direct debit and bank transfers. For more details, see What are
my payment options?

5 o i A e

If you have prepaid for your AdWords advertising, you can request a refund for the full remaining
balance of your account. You will find the refund request form via the "request refund’ fink on the ‘Make
Payments' section of your AdWords account,

it can take up to a week after you request a refund to account for any outstanding advertising activity not yet
displayed in your reporis. After all outstanding adverising charges post to your account, we'll Initiate the
transfer of funds to your bank account (sorry, no cash or check refunds) and send you a confirmation email,
It can then take an additional couple of weeks for you to receive the funds, due to potential delays in your
country's banking network.

After your refund is processed, you may make additional payments to your AdWords account. Your ads
will begin running again as soon as we receive a new payment. After we issue a refund, all paymenis we
receive (including payments initiated before a refund request) are considered atternpts to reactivate an
account.

Don't worry. You are not committed to a payment when you generate a reference number, If you lose the
numkber, simply generate another one. If you decide that you'd like to pay less or more than the amount you
entered on your transfer information receipt, you may also do so by generating another reference number.

Hoyr . ciangs my ceedit card ilormetion?

1. Log in to your Adwords account.

2. Select the My Account tab.

a. Click Billing Preferences.

4. Under Payment Details, click edit.

5. Use the pull-down menu to sefect your credit card type. (if you are switching to a new
card select the name of the new card.) Enter the new card information. Click Save Ghanges.

GApNe

Howng doTetapisboke?: =

If you have prepaid for your AdWords advertising, you can request a refund for the full remaining balance of
your account. The time it takes for you te receive a refund varies based on local bank networks. Please
allow 3-4 weeks for the enlire refund process. W, after 4 weeks, your refund payment does not appear in
your bank account, please contact us.

antisncsra hngreduestiioc sk tf

Yes. Contact us within 3-5 days of requesting a refund for your prepaid AdWords account. If we haven't
already initiated the transfer of funds to your bank account, we may be able to place a stop on the refund.
Remember, refunds are only applied o prepaid AdWords accounts.

AdWords billing & payments : Understanding AdWords billing
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Wit ygoburn ¢

With the AdWords post-pay option, you pay only for clicks or impressions you've actually received, so
you are not billed in advanca.

We create an invoice for your advertising charges and bill your account every 30 days, or after a certain
amount of advertising charges {as determined by history in the program) accrues. If you run a cost-per-click
{CPC) campaign, you accrue charges with every click; for a cost-per-impression (CPM) campaign, you
accrue charges each time your ad is shown.

The initiat credit limit of $50 is incrementally raised each time an account hits its credit limit before 30 days
have ended, The credit limit is first raised to US$200, then to US$350, and then to 1IS$500. The amount
invoiced and/or bitled may be slightly in excess of the credit limit if an account accrues clicks very quickly.

For advertisers who meet our criteria, we will consider increasing credit imits beyond US$500. Alihough
credit iimits cannot be increased in alf cases, we are happy to review all such requests. Please note that if
you are approved for a credit limit increase heyond US$500, your card will be billed every 30 days or after
your new limit is reached.

Vi et e s o

Choosing a maximum cost-per-click

The prefilled amount highlighted in blue is our recommended maximum CPC. Matching this amount
ensures maximum ad exposure and clicks for all of your keywords. Once you have decided on a maximum
CPC, click Calculate Estimates,

Choose currency and i ax{ W Vost~per-elick

Assess your cost, click, and position estimates

The traffic estimator returns estimates for how much you might pay per day for the keywords you have
chosen. In this example, the average cost per day is US$16.14 with an average CPGC of US$1.62. You'll also
see the average pOSIllon of your ad I-lere. the average posmon is 1.5.
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You may decide that the Traffic Estimator predicted too manyffew clicks at too high/low a CPC. If 50, you
can enter a new maximum CPC in the maximum CPC field and click Recalculate Estimates.

You will now see a new list of estimates. In this example, lowering the maximum CPC to US%1.50 from
US3$2.41 resulted in an average CPC that was, on average, US%0.86 fower. However, the average position
dropped from 1.5 to 2.3 and the average clicks per day dropped as well.

I cost is more important to you, you may choose ta go with this recalculated option. If position and
exposure areé more important, you may try option 1. '

Ghoaose cirency and ma 'mu'm cost-per-glick

You can update your billing information from the My Account tab. Your account won'i be activated and your
ads won't run unti! you submit your billing information for the first time. (If you are prepaying for your
AdWords advertising, your ads will not run untit we receive your first payment.} To submit your billing
information:

.Log in to your AdWords account.
.Click Billing Preferences under the My Account tab.

.Complete the account setup process.
.Click Save and Activate.

Note: Once your account is aclivated, any new ads and campaigns you create will begin running
immediately on Google. You will not be asked to submit your billing information every. time you create a
new ad or campaign.

To update billing information on an account which is already running:

-Log in to your AdWords account,

.Click the My Account lab.

-Click Billing Preferences.

Click edit in the 'Payment Details' section.
.Enter your updated billing information.
.Click Save Changes when you are finished.

iy Soimpeffors are it

In a word, no. We don't reveal individual data for any of our users.

However, we do have tools to help you calculate your own bid most effeclively.
The AdWaords Traffic Estimator will

show you the estimated average ranking of your ad, based on your bid.
Furthermore, the AdWords Discounter automatically adjusts your maximum cost-
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per-click (CPC) so you pay only one

cent more than the minimum amount
required to keep your ad's position.
For more about ranking, see How

are ads ranked?.

https/zdwords. googla com/suppovtbinfindes.

py?fulldump=) (ST of 1 16)8/212005 §:35:12 AM

Google AdWords does not curently mail or email invoices to most advertisers. However, you can
print both an invoice and a receipt for charges to your AdWords account. To print a recelpt, please
follow the steps below:

1. 1.Log in to your account.

2. 2 Click the "My Account’ tab to load your billing summary. (If you would like to view the
bifling summary for a specific date range, please select the appropriale manths and years from the drop-
down mentt al the top of the page once your billing summary has loaded.)

3. 3. Click ‘Payment received' for any line item refiecting a charge to your account. (You can
also download your entire billing summary by clicking ‘Download as .csv file' immediately above your billing
summary information.)

4. 4. Click "Printable receipt’ above the 'Payment Received' box. This will open your receipt in a new
window,

5. s. From your browser menu, select 'File' then "Print."

8. 6. From the printer prompt click *Print.*

To print an invoice, please follow the steps betow:

1. 1. Log in to your account.

2. 2. Click the 'My Account' teb to load your billing summary. {if you would like to view the
billing surmmary for a specific date range, please select the appropriate months and years from the drop-
down menu al the top of the page once your billing summary has loaded.)

3 3. Click the involce number for any line item reflecting a eharge to your account.

4. 4 Click 'Printable invoice' above the Invoice Details’ box. This will open em your browser
menu, select 'File' then 'Print.”

5. 5.From the printer prompt, click ‘Print.’

After you pause or delete alt of your campaigns, you don't accrue any additional charges to your Google
AdWords account. However, because the AdWords program bilts on a 20-day billing cycle, you may
raceive a charge up o 30 days after you have paused or daleted your campaigns. You wilf be charged for
any activity that occured before you pause or delete a campalgn.

You can verify the accuracy of a charge by adjusting the date range on the campaign summary page of your
account to include the dates betwsen your previous invoice and your tatest invoice. You'll then see the
statistics of clicks and impressions accrued between the selected dates.
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if you have chosen post-pay as your form of payment, you will typically have pending charges. Your pending
charges are determined by the amount of activity your ads have received since the las! time you were billed.
To view pending charges for your campaign:

. . Log in to your AdWords account.
. . Click the My Account tab at the top of the page.

- On the Billing Summary page that appears, check your outstanding balance (this reflects
the cost of aclivity since you were last billed).

Note: The outstanding balance in your account provides an eslimate for upcoming charges for your
campaigns. Please nole that this amount does not necessarily reflect a definquent amount, or a finat
balance, It is likely that the outstanding balance in your account is more than what you are actually
charged for that time period; we will deduct overdelivery credits prior 1o billing your account. All credits
and past charges posted to your credit card are also available under the My Account tab.

ok et g ot mi

To improve fhe overall AdWords billing experience, we're upgrading most
AdWords accounts to a new billing system over the next few months. The-
updated Billing Summary page will continue to reflect detailed infarmation
regarding account charges and aclivity, and will inciude the following changes:

-Your outstanding balance will now refleci any advertising charges since you
ware last billed to help you estimate upcoming charges for your campaigns.
However, this amount does not necessarily reflect a delinquent amount or a

ds.google.comsupporUbin/index py?fulldump-1 {38 of [ 16)8/2/2005 8:35:12 AM
Tna! balance due,

“Your ad delivery period will reflect more specific date ranges. Adverlising costs will be itemized only for the

particular month you are viewing to help make reconciling your charges easier. We recommend that you use
the Advertising Costs page for each month (which lists your charge details per campaign per month) when
reconciling your billing summary,

We hope that these changes help make your review and reconciliation of your AdWords spending simpler.

Reaching my audience : Reaching certain regions and language speakers

New campaigns (for new AdWords advenlsers):

. From the AdWords homepage, click Click to begin under Sign Up Now. You'll arrive at
the campaign wizard.
. After naming your Ad Group, select your target language(s) from the scroli-down box.

. Now select the radio button beside one of the three locatron options (Countries, Regions
and cities, or Customized)

. Click Continue.
l:l.. Now select your target location(s):

. If you chose the Countries option: Select one or more countries from the scroll-down box
on the left, then click ‘add.” Your selection(s) will appear on the right side of your screen.

. if you chose the Regions and cities option: Select your couniry from the drop-down box,
then proceed to add cities or regions below.
. . if you chose the Customized option: Select your targeting method (either physica
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atdress of latitude and longitude} using the radio buttons. Enter your location information in the appropriate
fields. Designate the radius within which you'd like your ads to be shown.

On this page you also may choose the advanced multi-
point oplion, which allows you to enter coordinates to
outline the precise shape and size of your target area.

. Ciick Continue.
. Follow the wizard instructions to finish creating your campaign.

New campaigns (for existing AdWords advertisers):

. LOG iMu pour Adrionse conn.
. . After naming your new campaign and Ad Group, selecl your target language(s) from the
scroli-down box.
. Now select the radio button beside one of the three location options (Countries, Regions
and cities, or Customized)
. Click Continue.

I:l.. Now select your target location{s):

. {f you chose the Countries option: Select one or more countries from the scroli-down box
on the left, then click *add.’ Your selection(s} will appear on the right side of your screen.

. If you chose the Regions and cities option: Select your country from the drop-down box,

then proceed to add cities or regions below.

. If you chose the Customized option: Select your targeting method (ellher physical
address or latifude and longitude)} using the radio buttons. Enter your location information in the appropriate
fields. Designate the radius within which you'd like your ads to be shown.

On this page you alse may choose the advanced mulli-
point option, which aliows you to enter coordinates to
outline the precise shape and size of your target area.

. Click Continue.
. Follow the wizard instructions teo finish creating yeur campaign.

Existing campaigns:

| 5T+ {1 [PO—
. Select the checkhox(es) next to the campaign{s) you wish to edit.
. Click Edit Settings above the Ad Groups table.
On the Edit Campaign Settings page, find the Languages field. Select your ad's target
language(s) from the

httpsHfadwords.google.comd infindex.py?fulldump=1 {59 of 116)272/2005 8:35:12 AM

scroli-down boxes.
. Find the Locations fleld. Click Edit to change your campaign’s target locations. Click
Contlnue to return to the Edit Settings page.
. When you're done, click Save All Changes.

You can find the coordinates for your business location at a variety of mapping sites such as Maporama or
Multimap.

To find your coordinates on Maporama:
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. Visit the Maporama website.

. Under the Maps header on the left side of yourt screen, select your target country from the
drop down box, then enter your address informaltion in the appropriate fields.
. . Click Go.

A graphical depiction of your address will appear in a map. Locate the Information
header be{ow this map. Your caordlnates wilf appear beside the phrase Lat-Long.

To find your coordinates on Multimap:

. Visit the Multimap website.

. Click the Maps tab at the top of your screen.

. Below the Quicksearch header on the left side of your screen, select your target country
from the drop down box, then enter your address information in the appropriate fields.

. Click Find.

A graphical depiction of your address will appear in a map. Locate the Map Informatlon
header below this map. Your coordinates will appear in the second line of text.

Regardless of the mapping site you choose, your coordinates will appear in the same general format, For
example, the iatitude and longitude for 1600 Amphitheatre Parkway, Mountain View, CA 94043 USA is:

37° 25 38", -122* 5’ 57"

When you target your ads to geographic locations, you have the foliowing three options:

. .Countries: Your ads will appear fo customers located in or searching for results in the country or
countries you select. This option is best suited for glabal businesses and merchants who serve specific
countries.

- Regions/cities: Your ads will only appear to customers searching for results In {or located
|n) the regional areas/cities you choose. This option is best suited for businesses specializing in certain cities
and states and stores with target customers located throughout a city or cltles. (Please note this regional
aption is only available in some countries.)

Customized: Your ads will only appear to customers searching for results in {or located
m) a specnf ied distance from your business. This option is best suited for businesses serving a specific area.

Regional and customized targeting is designed to benefit advertisers who want to reach customers in
specific geographic areas. For these advedisers, it's a powerful way to reach more qualified
prospects,

if this seems appropriate for your business, you may want lo create a regicnally-targeted or customized
campaign in addition to a country-targeted campaign.

Sometimes we're unable to determine the intended region or the physical
location of a searcher. This may occur when:

The searcher hasn't entered location-specific terms in his or her query.
N The searcher has ambiguous location terms.
The searcher's internet service provider (ISP) employs a proxy server, preventing us from
|dent|fy|ng his ar her

hitps Hadwords.google.comfsupportbinfindex.py falldamp=1 {60 of 1 L6}3/2/2005 8:35:12 AM
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IP address,

Because we can't determine the searcher's location in these cases, we'll show nationally-targeted ads
instead of regionally-targeted ads.

Helpful Tip: Need help with finding your ad? Our Ads Diagnostic Tool can let you know whethar your ad is
appearing on the first page of search results, and identify why a padicular ad or group of ads may not be
showing. You can access the tool at any time via the Tools link on the Campaign Management tab.

‘The AdWords system first analyzes a searcher's query to establish what region that person is searching for.
It may also take note of the person’s internet Protocol (IP) address to see where he or she is searching from.
The system will then examine these factors and others to delermine the best targeting for your ads.

Il the AdWords system can't identify appropriate targeting for your ads, it will show nationaliglobal ads
instead.

fif acZapisbars. -

Your regionally-targeted and customized ads can appear alongside search resulls for Google users in
your targeled location(s). We identify a user's geographic location by using the computer's P {Internet
Protocol) address.

In the United States, your regionally-targeted and customized ads can also appear alongside Google
search results for location-specific search queries (such as 'New York pizza'), regardless of the searcher's
geographic location.

if your campaign is opted in to Google's search and content networks, your cuslomized or regionafly-
targeted ads can atso show on some sites and products in the Google Network. However, they currently
won't appear on AOL. Only country-targeted ads will appear on the entire Google Network.

Remember, you can slill reach prospects on all partner sites (including ACL), by creating additiona!,
country-targeted campaigns. Just remember to include location-specific keywords and ad text in your
campaign.

Yes. Simply create new campaigns, each targeted to different geographic locations, to maximize your
advertising reach. For example, your account might contain a campaign showing ads to one or more
countries, a campaign showing ads to reglons/cities, and a campaign only showing ads within a set distance
from your business location. You can then modify the ad text in each campaign to make your ads more
relevant to your target prospects in various geographies.

When you're tailoring your ad text, remember the following:

. You won't need to include place or region names in the ad text of your regionally-targeted
or customized campaigns because the AdWords system will automatically focus your ads to the region
you've specified. Users searching on broad keywords, such as ‘refrigerator maintenance,’ will still see your
ads.

. You should, however, include place or region names in the ad text of your country-
targeted campaigns if you want to attract users outside your area, In this instance, you would include mora
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specific keyword phrases and place names in your ad text, such as 'New York refrigerator mainlenance.’

ivited laigeling, vl wiktnsy ads lookfke? -

AdWords will identify your chosen region or cily in your regionally-targeted ads fo
distinguish them from country-targeted ads. For example, the following ad is
regionaliy-targeted to the New York, NY area:

WidgetWorld
Wide variety of widgels.
Check out our special deals,

widgets.google.com
MNew York, NY

if you use customized targeting, the location will not show in the last line of your
ad.

i my uosf-p'ai l:ick (GP C),I:ldling ninnrﬂs’?

MNo. CPC estimates will be calculated the same way for nationally-targeted and regionally-targeted
canmpaigns.

lf you select the customized targeting option for your campaign(s), your ads will only appear to customers
searching for resulls within {or located within) a specified distance from your business. The reglon where
your ads appear will be typically be a circle around your business location.

. . First you set the center of this regior with your business address or latitude and longitude
coordinates.
You then set the advertising distance {the radius of the circle) in miles or kitometers.
. The AdWords system will translate searchers' locations into latitude and fongitude
ooordmates and determine whether they fall into your target region.

You can targel your ads to multipfe languages and over 250 countries. You can also target regions/cities
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within a limited number of countries.

You may change these language, country, and regional settings at any time.

Corifiy campalgf eradk regionl eveas (risinting Slles sod defeshin momple, counifas?

No. Your campaign may only target regional areas in the same country. However, you may create a
separate campaign for each unigue country containing areas you'd like to target.

‘Hovedogs Iargeting by botlinde seyflongide oz - 0 B = s S

If you select the cuslomized targeting oplion for your campaign, your advertising region will be a circle
around your business localion. However, you can modify the shape of your adverlising region by choosing at
least three latitude and longitude points on the map. The AdWords system will connect these points to
define a targeting area of virtually any size and shape. Your ads will appear fo people searching within this

HE choose raglonal orcufomlzed targeling Wil my keyword Lmfic cstimedes b affected?

Yes. Because campaigns with regionat and customized targeting focus on a narrower audience, keyword
traffic estimates may be lower than those for nationally-targeted campaigns. The actual difference in traffic
estimates will be determined by the regions you larget.

We've found that we can determine the searcher's desired location correctly in the majority of lests we've
run. In addition, because your ads clearly display their target regions at the bottom of the ad text, chances
are minimal that a searcher not interested in that area wouid click on your ad if it were incorrectly targeted.
Therefore, we won't issue credits for incorrectly targeted ads.

Reaching my audience : Making my keywords work for me : Selecting the right keywords

After selting your advertising goals, the next step is to build out your keywords. This can somelimes be
daunting, espacially if you're just beginning, but here are 4 steps to get you started on the path to creating
an effective keyword list:
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1. Expand your keyword list to include as many relevant words ais possible.
2. Target the keyword list by using keyword matching options.

3. Scrub or refine the keyword list.

4 Group the keywords in thematic clusters fo he paired with different ads.

AN

Step 1: Expand
“First, review your site content to identify which keywords {word combinations and phrases) describe the
main categories of your business. Write down every relevant keyword under each category you find. Expand
the list by including all of your brand and product names as well as plurals and synonyms for each word or
phrase on your initiat list. Also, remember to think fike your customers. How might your customers ask for
your product or service? {Don't worry about capitalization — our system is not case-sensitive.)

If you're still looking for more keywords after your own brainstorming, try out our keyword tool,

Step 2: Target

Now it's lime to target your keywards using Google's keyword matching options. These enable you to pin
point ad deliver so your ads reach people precisely when they are searching for what you have 1o offer. You
can choose to designate each of your keywords as z broad, phrase, exact or negative match. Each type of
match provides a varying degree of exposure.

For example, a broad-matched keyword will allow your ad to appear on your keyword as well as variations
and synonyms of that keyword that the AdWords system identifies as relevant. However, a negative~
matched keyword will never trigger your ad. Decide which of your keywords you would like fo place where
along this spectrum.

Step 3: Scrub

After creating, expanding, and targeting your list of keywords, it's time to refine it. To do this, review

your list and make sure you're salisfied with what you've come up with. Eliminate any keywords that

may be irrelevant.

Step 4: Group

You've already created different 'buckets’ for your words based on your product lines. Now if's time Lo do
even more refined and granular grouping into themalic categories, which are called Ad Groups. Organizing
and grouping keywords is crucial because you have to write ad copy targeled to each group.

hodegordiceas? -

The best place to start your keyword search is on your own website. Reading through your web pages will
help you identify the key themes and terminology assaciated with your business or product lines.

Then, take a minute to try to think like your customers (your target audience). What are the terms your
customers would use to describe your product or service? Often these colloquialisms are overooked,
yet they are valuable alternatives for your keyword list.

Finally, the keyword tool can provide you with terms. It will give you common search queries including or
pertaining to your keywords. You can use the relevant resulls to supplement your list. And you can add any
irrelevant {arms to your keyword list as negative matches.

Our system doesn't recognize URLs as keywords; therefore, Google AdWords ads won't display for
keywords in the form of a URL (www.domain.com, for example). If a user searches for your domain URL,
your website will sppear in the Google search resulls, but no ads will appear. We recommend that you
select keywords that are relevant to your products and services and refrain from using URLs as keywords.
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I6the Kefwaed Toolquarasted o prshacorgroa raduts- :

The Keyword Tool is nol guaranteed to produce keywords that will imprave your campaign's
performance. It is a useful tool for helping you discover keywords that may be refated to your account.

However, some of the lerms may nol be relevant for you. In this case, you may consider adding them as
negative matches.

All keywords you add to your keyword lists are subject to review according to both our editorial discretion
and policies, which are applied outside any data the Keyword Tool may relurn on a given search. The
alternatives you may receive for your submitted keywords are not edited to ensure that we provide the most
accurate representation of Google search behaviors, and of what keywords may trigger your ads. Please
also note that the Keywaord Tool does not take the individual performance or content of your existing ad(s)
into account when returning keyword alternatives.

You may notice occasional changes in your Keyword Tool results for a given keyword. As part of our
ongoing effort to improve the Google AdWords program for advertisers and users, we may periodically
update our keyword index to give you more relevant and current keywords.

Learn more about building an effective keyword fist,

Reaching my audience : Making my keywords work for me : Keyword matching options

What s bépyord tetching ptons?

Keyword matching options are four differant methods of targeling your AdWords
ads to users. With some optlons, you'll enjoy more ad impressions; with others,
you'll get fewer impressions (but potentially more clicks). By applying more
focused matching options to your keywords, you can reach the most appropriate
prospects, reduce your cost-per-click (CPC), and increase your RO,

Your options are:

Broad Match - This is the default option. If you include general keyword or
keyword phrases-such as fennis shoes-in your keyword list, your ads will
appaar when a user's query contains fennis and shoes, in any order,

dwaords.google camys inindex pyTfulldump=1 (64 of | 16)8/2/2005 $:35:12 AM.

and possibly along with other terms. Your ads will also automalically show for expanded matches, including
plurals and relevant variations. Because broad matches are sometimes less targeted than exact or phrase
matches, you should create keyword phrases containing at least two descriplive words each. You can also
try the keyword tool and the other three maiching options to further refine your targeting. Finally, keep in
mind that other advertisers may have bid for the same broad-matched keyword combinations that trigger
your ads,

increasing your actual CPC amounts. Using exact, phrase, or negative imalches can help you keep your
costs low.

Phrase Match - If you enter your keyword in quotaiion marks, as in “lennis shoes,” your ad will appear when
& user searchas on the phrase lennis shoes, in this order, and possibly with other terms in the query. For
example, your ad will appear for the query red fennis shoes but not for shoes for tennis. Phrase matching is
more targeted than broad matching, but sfightly more flexible than exact matching. Te ensure your ads are
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as targeted as they can be, you may want te include at least two descriptive words in your keyword phrases.

Exact Match - If you surround your keywords in brackets-such as {fennis shoesf-your ads will appear
when users search for the specific phrase tennis shoes, in this order, and without any other terms in the
query. For example, your ad won't show for the query red fennis shoes. Exact matching is the most
targeted option. Although you won't receive as many impressions with exact matching, you'll fikely enjoy
the most clicks, because users searching for terms in this manner typically want precisely what your
business has to offer.

Negative Keyword - If your keyword is fennis shoes and you add the negative keyword -red, your ad will
not appear when a user searches on red tennis shoss., You can apply this option for a keyword at both the
Ad Group and campaign level.

To learn more about the benefits of keyword matching options, view our brief online demo,

You can also easily change the match options for muitiple keywords throughout your aceount with our find
and edit keyword too] located in the Tools section of the Campaign Management tab.

With expanded matching, the Google AdWords system automalically runs your ads on highly relevant
keywords, including synonyms, refated phrases, and plurals, even if they aren't in your keyward lists. For
exampte, if you're currently running ads on the keyword web hosting, expanded malching may identify the
keyword website hosting for you. The expanded matches will change over time as we learn more about
which new keywords best suit the true meaning of your ads.

Expanded matching only applies to your broad-matched keywords. This feature doesn't affect keywords
you've specified as phrase matches (keywords surrounded by double quotation marks) or exact matches
{keywords surrounded by [} brackets). Also, expanded-malch terms aren't included in our calculations for
your minimum CTR requirement; therefore, they don't affect your ad's rank.

Google AdWords provides an easy way for you to menitor the status of your
keywords and their associated ads.

You can proactively moniter your keyword performance by revigwing the
status column on your keyword summary page. Each of your keyweords
{except any negative keywords) will be identlified by one of the following
states:

Normal: Targeted keywords are above the minimum 0.5% CTR on Google search pages,
and their assocuated ads show regularly. There's currently tillle to no risk to your advertising exposure.
However, every Ad Group can use occasional optimization, so you may want to consider periodic re-
evaluation of your ad text and keywords. -

. In trlal: Keywords are slightly below the minimum threshold and are in evaluation untit
we re statistically confident their CTR is below or above 0.5%. These keywords may become normat or
disabled. They may alsc be slowed, giving you an opportunity to refine them as needed.

Thereare a ﬂmiled number of in trial keywords per account, so when this
limit is reached, additional keywords will be moved to on hold status with
priority given to those keywords with higher predicted CTRs. Accounts
that have proven to perform very weli wift be rewarded with a greater
number of in trial keywords. The fimitation placed on the number of
keywords that may be placed in trial helps ensure that advertisers
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continue fo see the most targeted, relevant ads via the AdWords program.

https:Hadwords. gnogle. /s findex.py 7F 1 {65 of 11624272005 8:35:12 AM

. On hold Your account's in frial keyword limit has been reached, and these additional
keywords are slightly below the minimum threshaold. As more space becomes available, these keywords will
move into in trial status, with priority given to those keywords with higher predicted CTRs. There is no limit
placed on the number of on hold keywords you may have within your account. You may want to refine these
keywords.

. Disabled: Disabled keywords no fonger trigger your ads. if you still feel strongly about
usmg these keywords, you have a few options.

if 'normal’ appears beside your keywords, your keywords are performing adequately, and you don't need to
take any action unless you'd like lo.

my bRo3-ad dhigse: T

Broad and phrase keyword matching options allow your ads to appear for queries that don't exactly match
your keywerds. This provides you with additional ad coverage without having to generate an exhaustive
keywaord list. However, what if not alf variations work well for you or what if a keyword isn't as targeted as it
could be to begin with? There is a greater chance that you'll accrue less-targeted clicks and inflate your
costs. We take a couple steps to help prevent this.

First, your broad- and phrase- matched keyword variations must maintain a high relevance facior
(automatically determined by analysis of Google search queries, your ad text, keywords, and CTR).
The evaluation of these matches is, in mosi cases, stricter than the CTR performance requirement for
the exact keyword form.

Additionally, the keyword variations and expanded broad maiches are monitored closely and can be
disabled if they don't achieve a high enough relevance factor. (Your original keyword can continue to be
aclive even if some of its variations are disabled.) This way, your keywords aren't penalized for
underperforming variations or expansions.

Apacedmehingbeneltme?. . w0

Expanded matching offers the following benefits:

Because your ads are associated with additional keywards, they'li appear more often to
your potentlal customers. And because these new keywords are so relevant, your ads show to people who
will likely be interested in clicking on your ads.

. Expanded matching is a "smart” feature. I{ automatically retains only the highast-
performlng new keywords. After a few cycles, it leams what additional keywords o create in the future
based on the most successful combinations.

. The AdWords system constantly monitors all user queries and bases its optimization on
the analysis of these queries. It increases your refevance to prospects by automatically tuning your lists over
time-without requiring any additional effort from you.

You can view sample matches by entering a keyword into the keyword tool. You can add the expanded
matches to your account manually. However we recommend you let the system automatically tune your
malches over lime as it continually enalyzes your performance.
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Yes. If you don't want your ads appearing on particular expanded-match keywords, you can add that
parlicular keyword as a negative mateh in your keyword list.

Also, expanded matching only applies to broad-matched keywords. The system won't create expanded
matches for any of your phrase- or exact-matched keywords. Therefore, if you don't want expanded
matching on any of your keywords, you can simply turn them into phrase or exact matches. (Keep in mind
that narrowing your advertising focus wilh phrase or exact matching may docrease the number of ad
impressions you receive. However, because your ads will be more relevant to target users, your clickthrough
rate may also improve.)

Reaching my audience : Places where my ads will appear : The Google
Network

The Google Network is made up of sites and products who parln r with Goog]e to publ:sh targeted
AdWords ads via their site or product. Google can target your ads to search results and relevant web
content on a wide variety of sites and products o help you reach a vast and highly-targeted audience. We
are constantly expanding the number of sites and products in our network through our premium services
and our online Google AdSense program. All web

sites and products are reviewed and monitored according to the same rigorous standards, so as the
network grows, your AdWords ads will continue to appear only on high-quality sites and products.

Besides appearing on search results on Google.com, AdWords advertisers can choose Lo hava their
keyword-largeted campaigns appear on our search nefwork, our content network, or both. New keyword-
targeted campaigns are aulomatically opted in to distribution on the Google Network, so if you want your
ads to appear on search and content sites and products, then you don't need to do a thing. To learn how
to view or edit your distribution preferences, please click here.

As an AdWords adveriiser, you also can elect to create site-targeted campaigns, in which you choose the
exact sites where your ad will appear rather than choosing keywords to trigger your ads. Site-targeted
campaigns appear only on conlent sites in the Google Network, and only websites and only on the specific
sites you select. They don't appear on other siles in the Google Nelwork or on Googte.com. To learn more
about site targeting, please see click here

Other Google Network facts you might like to know:

- MNo additional fee to participate in this program.

- Some sites and products show as few as the top 3 ads per page, so the higher your
average ad position, the more exposure you'll get.

. All ads are reviewed before appearing across the Google Network, 5o you may see your
ad appear on Google first. Please note that if you edit a previously reviewed ad, your ad will show on the
Google Network once it is reviewed again.

Google offers several ways for you to join the Goagle Network and display AdWaords ads on your site.

Goagle AdSense for content-A fast and easy way 10 unleash the true revenue potential of your web content pages. Web publishars of any size can
apply online. Once approved, you can publish AdWords a<ds on yous sife within minutes, i your site receives more than 20 million page views a
month, you may be eligible for premium service,

Google AdSense for search -Wabsites that condugt a minimumn of § million searches per month can display AdWords ada on their seasch results
pages.
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1 CDoage heSpocic siat i 10 Goigo Notuc horg my s Bpgoae? - -
You can select individual sites where your ads will appear by running a site-targeted AdWords campaign.

You're given the choice of site targeting or keyword targeting each lime you create a new campaign. Each
new campaign can use site targeting or keyword targeting, but not both. Site-targeted ads appear only on
content siles in the Google Nefwork, and only on the individual sites you selact. The don't appear on search
network sites or on Google.com. Keyword-largeted campaigns appear across the entire Google Network,
but are not eligible for site targeting.

For more about site-targeted campaigns, please see our FAQ,

tien i1tz Googhy Netwi aifSct .

To make your keyword-targeted advertising as effective as possible for you and your users, we require that
your account and individual keywords maintain & minimum clickthrough rate (or CTR). However, while
tabulating and evaluating your CTR, we enly consider aclivity on the Google search pages. Your ads
distributed to the Google Network are not used in evaluating your performance.

Reaching my audlence : Places where iny ads will appear : Showing my ads on search network

Ad appearance will vary by Google Network parlner. However, the ads are typically labeled as sponsored fnks
and could clude 2 - 4 linas of text. Ads may appear either down the side of or above the search results, Hera is
an example of what your ad could look like on Google:

https:Hadwords google.com/supportbinfindex.py?fulldump=1 {67 of | L6}R/2/2005 8:35:12 AM
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Your ads will always appear on the Google search site, but you can choose whether your Google AdWords campaigns also appear on either of our
search or content networks, or both. To view or edit your distribution preferences, please click here,

We recommend advertisers distribute their ads anmss'the entire Google Network, as it maximizes the number of highly-gualified feads that you can
receive. Gongle technology ensures that your ads appear enly on high-quatity pages and products that are directly relevant to your service. As
always wilh Gougle AdWords, you only pay for clicks you recelve, S0 you have nothing to lose but potential customers.

Reaching my audience : Places where my ads will appear : Showing my ads on content network

Conlextual advertising, sometimes referred to as Content Targeting, is an innovative feature of Google AdWords that enables your te gain mare

082



Case 5:05-cv-03649-JW Document 18-3  Filed 11/14_/20})5 Page 35 of 52

customers easher than ever balfore. Bullding on our suscessful keyword targeling lechnology, we place highly-largeted AdWords ads on content
pages within our extonsive network of high-quality partner sites and preducts, This service, known as contextual advertising, improves the
expenance of web users by displaying usafl ads, and it provides several benefits to Google agvertisers:

1. 1. RO Performance: Kayword-targeted contextual ads bring unique, pre-cualified leads for a cost-per-click that you set yourself,
2. 2. Extend reach: Increase the number of potential customers that see your ads, and drive more incrementat glicks to your
wabsite than you could reach with search advettising alone.

Bave Time and Money: Coantextual largeting is one of the fastest and easiost ways to get your ads to more relavant places
on the Web, Ancf you only pay for clicks that you recelve,

By electing to show your ads on the Google content network, you can expand your reach to prospects
visiting a variely of high quality websites that are relevant to your business. However, there may be times
where—for any reason—you feel that certain websites aren’t appropriate for your ads. If this is the case, you
can apply the AdWords site exclusion feature to prevent your ads from appearing on these sites. With the
site exclusion feature, you can enjoy the bensfits of advertising on the content network while still precisely
controlling your targeting.

Please note the {ollowing about the site exclusion feature:

This feature is available only to advertisers who are opted in to the eontent network.

The content network is continually evolving and growing. As a result, we can't provide a
hst of alt snes which are eligible to show your ads. By using this feature you can simply filter unwanted sites
in case they are or become part of the content network.

. You may edit your list of excluded sites at any time, and as often as you like.

if you'd like lo use the site exclusion feature, follow these simple instructions.

[ e S A T ey

To prevent your ads from appearing on specific websites, you may apply the
AdWords site exclusion feature. First you may wish to confirm that you're opted
into the content network. You can then follow these instructions:

i 1. Log in to your AdWords account.

2. 2. Click Tools at the top of your Campaign Summary page.

3. a. Click Site Exclusion under the Modify Your Campaigns header.

4. 4. Select your campaign from the drop down box and dlick Go.

01.5. In the field under "Add sites to be excluded,’ fist the websites you want to exclude from showing your
ads.

. . Add only one website per line. Do not separate websites wilh commas or other
punctuation.

. Enter websites at the domain (www.example.com, example.com), subdomain
(toplc example.com), or path {(www.example.com/stuff} level only.

- Do not enter individual pages (www.example.com/main.html).

hups:iadwords.google. com/suppostbinfindex. py?fulldump=| {68 of 116)B/2/2005 §:35:12 AM. )
6. When you're done, click Save List. You'll see a confimmalion page informing you how many wehbsites
you've chosen to exclude.

Please note that you may exclude sites only at the campaign level. That is, if your account contains
myitiple campalgns, you must create a list of excluded sites for each campaign if you want to filter
unwanted websiles completely.

With the AdWords sile exclusion fealure, you have several options for filtering websites. You may enter a
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domain, subdomain, or path name. You may not enter individual pages.

The format of each entry on your site exclusion list determines how the AdWords system will filter sites.

Acceptable formats:

. Domain: www.example.com

- Domain: example.com

. Subdomain: unwanted.example.com

. One path name: www.example com/widgets
One path name: example.comiwidgets

Unacceptable formats:

. Multipte path names: www.example.com/widgetsfredwidgets

«Individual page: www.example.com/findex.html. Site Exclusion Scenarios: In general, entering
domains will prevent your ads from appearing on any page on or within that domain. However,

entering subdomains or paths will only prevent your ads from appearing on any page on or within that
subdomain or
path.

For instance:

If you enter example.com. ..

Your ads will not appear on example.com, www.example.com, wwwi.example.com,
www.example.com/widgets, www_example.comiwidgets/page.html, or unwanted.examptle.com.
If you enter www.example.com . ..

. Your ads will not appear on www.example.com, www.example.comiwidgets, etc.
. Your ads may appeat on www1_example.com or unwanted.example.com.

if you enter www.example.comfwidgets . ..

. . Your ads will not appear on www.example.com/widgels or
www.example.com/widgels/page.himt.
. . Your ads may appear on www.example.com.

Text-based ads on our content network are the same ads that appear on the
search resulfs pages of Google and our global search partners. In addition,
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AdWords advertisers now can place image ads on content network siles if they
choose. Although ad placement will vary, AdWords ads are typically identified as
sponsored links. RanKing for ali contextual ads is determined just as on search
results pages—based on various factors like the maximum cost-per-click you have
selected, the clickthrough rate that your ad has established on Google.com, and
the quality of your ad text and keywords.

Google AdWords Ads on Confent Network

htps/fadwaords.google.comisupporvbinfindes. pyPhutldump1 (69 of | 16)8/2/2005 8:35:02 AM

ek Pavn
JAtpan Ay L

B P ottt § Ut Erst
v
A o Ty T bt h

Y¥etoome o Uog Cantor

AN AN Y A 5 32w b
i R b ey

R e M | e SR

o

AT

Creating effective ads that bring you sales on search and content pages Is easy. There are a few sleps you can take to ensure that your ads are
bringing you the highest possible relum on your advertising investment on Google search and canfent pages.

1. 1. Optimlze your campaigns as you woudd for search advertising. Search ads are typleally good predictors of eontextual
adveriising performance. This means thal the better your ads perform on search pages, the mote successful hey are fikely to ba on contenl sites and
products. For more information on improving your AdWords campaign, please visit our oplimization tips page,

L2 Implement Google convarsion fracking. Conversion tracking allows you to see the number of sales that you are recelving
from your advestising campaign, for both our search and content network sites and products. Reviewing your total number of convarsions and the
value of these conversions can help you determing if you should increase your budget or further aptimize your ad groups to receive more targeled
visitors. Leam more about '

Google convergion lracking.
2, 3. Review your ad ranking. ieep in mind that most content sites and producls only display two, thiee, of four contextual ads per
page. As aresult, you must sefect @ maximum cost-per-click that allows your ad 4o rank in these top positions if you are to take advantage of the
additionaf qualified clicks from cantent pages. Look at the average pesition of your ads on the Campaign Managemant page and adjust this position
as necessary (by Improving your clickthrough rate with refined ad text and keywords, or adjusting your maximum CPC) o ensure that you are
recelving as many profilable leads as possible.

Contextual advertising provides you additional iargeted visitors at a cost you set. However, because the performance of your ads on contenl pages
does not affect their performance on search, a lower number of clicks or clickthrough rate on contextual advertising will not adversely affect your
campalgns., .
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Your keyword-targeted ad is ranked on the search results and content pages based on various
performance factors including: maximum cost-per-click (CPC), clickthrough rate (CTR), and ad text. Having
relevant ad text, a high CPC and a strong CTR will result in a higher position for your ad.

Visit our Optimization Tips page to learn more about account optimization, including how to maximize
performance for your ads and improve your ad's position without having 1o raise your maximum CPC. You
can also learn about how to optimize ad serving for your ads on this page.

When you choose a maximum CPC for your keywords, our Traffic Estimator gives you the estimated
average ad position per keyword. This estimate is based on your maximum CPC and the average CTR for
each of the keywords you've chosen,

Though you set just one maximum CPC for a given keyword, content network
clicks aren't priced the same as search clicks. Google's smart pricing feature
automatically adjusts the cost of a keyword-targeted content click. So if our data
shows that a click from a content page is less likely to turn into actionable
business results - such as online sales,

hwps:Hadwords. google. /sup portbinfindex, py Tl 1 {70 of 116)8/2/2005 8:35:12 AM
registrations, phone calls, or newsletter signups - we reduce the price you pay for that click. With no extra
effort for you, Google technology helps ensure you get strong ROl from your AdWords advertising, wherever

your ads appear.

if you are a new or existing AdWords advertiser, your keyward-targeted ads automatically begin appearing
or relevant content sites and products. Utilizing our advanced search technology, Google scans the content
of & Web page and automnatically selects ads to display that have keywords closely matching the subject of
the page. For example, If users look al a Web page about building hummingbird feeders, they may see
Google AdWords ads for hummingbird feeders or hummingbird food. Or, if a users view a page containing
brownie recipes, they may see ads about chocolate brownies or delicious dessert recipes. You don't have to
waste time trying to find the right content venue to display your ads. Our advanced algorithm makes it easy
by displaying your ads awtomaticaliy for the most relevant content.
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1. _1. A web user visits a webpage looking for itemns to purchase that are related to your product.
2. 2. Your ad is matched automatically to the relevant page each time it is viewed.
3. 3. With cost-per-glick pricing. you pay only when a user clicks on your ad.

On Google’s content netwark, ads ane not riggered by specific individual keywords as lhey are on search sites_ instead, an adverfiser’s entire
keyword list is taken into consideration. Google's advanced lechnology scans the conlent of the web page and malches that contenl with ads that

feature the most appropriate keywords overall.

For example, if users look at a Web page containing brownie recipes, {hey may see your ad if you simply have brownie-related keywords such as
‘chocolate brownies® or ‘delicious dessert recipes.*

Since individual keywords don't tigger your ad, your Ad Group statistics wilt not show a keyword-by-keyword breakdown. Instead, you'l ses an overall
totat of all clicks that ad has received en our content netwark.

On a busy content page. an ad has 10 compete more o get e attention of a reader than it woutd on a search page, so content CTR is typically lower
than search CTR. Its nothing to worry abaul, because contant CTR does not affect the ranking of your ad on search pages.

The technology that dives AdWords conlextual adverlising comes from Google’s award-winning search and page ranking technelogy. Based on a
sophisticaled algosithm, we can comprehend & pane's meaning and then figure out which keyworts relale best to the content page. Then, we match
ads that are precisely targeled to the content page based on the associated keywords. This means that in addition to reaching customers who
spediiically search on your kaywords, you can now reach customers who view Web content directly refated to your AdWords ads. For exampla, i

someone visiis 8 web page on astronomy he/she woitkd be served Google AdWords ads far lelescopes. Conlexiual Advertising benefils Web users by
linking gontent with refevant products and services. This is great for Gongle advertisers like you, because you can now reach more prospactive
customars on more piaces on the Web.

With Goagle, you can say goadbye to contracts angd deadiines, Unlike a traditional online advertising buy,
Google's contenual advertising requires no prepayment and no packages. Just enjoy placement on web pages in
the Google Network that happen to hava just the right content, right then, to make a

hitpsladwords.google.com/supporvbinindecpy? ulldump=l (71 of 11618/2/1005 B:35:12 AM
match between your ad and an interested reader. With Goegle AdWards, you manage your campaign lo the performance metrics you want.
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{¢obgieEonteiual achiestising orks For my brasid? -+

We recognize that you may have display concerns specific to your company or brand. For instance, you may
not wish your ad to be shown next to an article about your company earnings. To customize Google
contextual advertising for such special circumstances, we recommend you apply appropriate negative
keywords or site exclusion to your campalgn. (For the example given, you might choose 'earnings’ as a
negative keyword, or you might choose to have your ads blocked from that entire website.) This will help
ensure your ad is not shown alongside content with the specific themes you wish 1o avold. You can update
and change these negative settings at any time. To leam more, please see our how-to pages on negative
heywords and site exclusion.

You may also wish to consider a site-targeted campaign, which allows you to select the precise sitas
where your ad will appear. For more on this AdWords feature, please visit our Site Targeting FAQ.

ok By pecimance of ranking of my ads? -

The parf 1ca of yowr contextual advertising does not affect the ranking of your ads in any way. We do require that your account and individual
keywords maintaln a minimum clickthrough rate (GTR) in order to ensure your adverlising is as effeclive as possible for you and for users, However,
becausa we only consider the performance of your ad on Goagle search pages when evaluating your account and keywords, contexiual advertising
does not impact your account performance in any way. Clicks from conlextual targeting mean additional qualified leads for you at no risk to the
peiformance of your campatgn,

Eﬁi_ﬁisﬁg""cmlexr'udéﬂw‘ljﬁng? R

Campaigns that produce great business results on search typically do well in he content natwork, Ad Groups with keyword lists that are focused
around a theme, product line, of brand tend to perform batter than Ad Groups with lists of unrelated keywords. And, Just as in search advertising, ad
text with 2 specific call lo action outperforms ad text that's simply descriplive, which may attrast more browsers than buyers.

dieneppropasy |

Google has a number of safeguards to help ensure that ads are not shown on inappropriate content. We use sophisticated technology to detect pages
with sensitive centent, and ensure thal no ads are served on them. In addition, wa have tools in place to immedialely remove: ads if they do appear on
apage with questionable conent, Publishers ke Forbes.com and many other distinguished properties st that our fifters work

Reaching my audience : Site-targeted campaigns

Site-targeted campaigns are a new enhancement to Google AdWords. Site
targeting lets advertisers choose individual sites in the Google content network
where they'd like their ads to appear. If you want to place your ad on a single
international website, you can. If you want to target dozens of siles about
basketball or orchids, you can do that too. Site largeting tets you hand-pick your
audience, big or small.

When you set up a site-fargeted campaign, you first name the sites where you'd
like to advertise, or just give us a list of words that describe your site. The
AdWords matching system does the rest, analyzing your input and crealing a fist
of available Google Network sites for you o choose from.

Remember thal a site must be part of the Google Network in order to he available
for your site-targeted campaign. Being part of the Google Metiwork means the site
has agreed to run ads provided by Google, which in turn allows your AdWords ad
to compete for that space.
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As with all AdWords advertising, you'i compete for space with other
advertisers. If you choose very prominent and popular sites, you'll need a
higher price 1o win the ad position. The minimum cost-per-thousand (CPM) bid
for a site-targeted ad is US$2.00.

Who should have site targeting? Should 1?
Anyone who has an AdWords account can run site-targeted ads.

Site-1argeted campaigns can be a good option for businesses who want to
promote an existing brand or a new product to a large audience. But they also
work for smalfl advertisers who want to reach a very precise audience. As
always with AdWords, we suggest that you experiment and see what works
best for you.

Of course, if you're happy with your keyword-targeted ads, there’s no need to
change. Site targsting is not replacing

https:fiadwords. poogle. supporybinfindex pytaftdump=1 (72 of 116)872/3005 §:35:12 AM
keyword targeling, and everything you love about your AdWords keyword-targeted campaigns remains
the same. Site targeting is simply one mora tool that AdWords advertisers can use to bring their message

to highly-targeted groups of web users.

How do | create site-targeted ad campaigns?

To create a new site-targeted campaign, please click here. For more general information aboul site
targeling, please see the complete FAQ.

Howf i | eredle o siteslargeted empdign?

You can create a site-targeted or a keyword-targeted campaign at any lime. Each new campaign can use
site largeting or keyword targefing, but not hoth. Site-targeted ads appear only on the Google content
network, and only on the sites you select.

To create a new site-targeted campaign, follow these steps:

. . Log in to your AdWords account at hiip:/fadwords.google.com (if you're not already logged
in).
. . On the Campaign Summary page, click the 'Create a new site-targeted campaign' link just
above the table of existing campaigns.

Follow the sign-up wizard instructions to create your campaign.

gaterady: .

in CPM advertising, advertisers set the maximum amount {(max CPM) they're willing to pay for each 1000
imprassions their ad receives. The price paid is the same whether users click on the ad or not. This is
different from cost-per-click (CPC) campaigns, where adverlisers pay only when their ad receives a click.

Advertisers have told us that CPM pricing is a tool they'd like to have available for their AdWords
campaigns. Some adverlisers wanl the flexibility to reach customers early in the advertising cycle, with
ads designed to increase awareness but not necessarily generate clicks or traffic. Others prefer the

089



Case 5:05-0v-03649,_-J\7)/ Document 18-3  Filed 11/14/205)5 Page 42 of 52

traditional industry metrics of CPM eampaigns. As a result, we're making CPM pricing avaitable to those
who prefer it.

CPM pricing is currenlly available only with sitetargeted ads. Advedisers select the sites where they'd like
their ad to appear, and sel a max CPM that applies for all those sites. CPM ads are then ranked for display
according to their max CPM, competing with other CPM ads and with keyword-targeted cost-per-click
{CPC) ads. A CPM ad occupies the entire ad space, with either an image ad or an expanded text ad.

As always, the AdWords discounter automatically reduces any winning CPM bid so that the amount
charged is the minimum necessary to keep the ad's position on the page. As a result, the max CPM an
advertiser sets is rarely the amount actually pald,

Google ads with CPM pricing continue to have a very high tevel of relevancy. CPM advertisers use site
largeling to sefect the specific audience that will be interested in their message. CPM ads compete with
keyword-targeted cost-per-click ads, and high relevancy continues to hoost the ranking of those CPC ads.
We also have set a high minimum CPM value to ensure that advertisers choose their ads and their
audiencas with care.

For more about how CFPM ads are ranked, please see How do CPM and CPC ads compete with each other?

*How 85 Sitetergited widkeyword torgeted ads Gt

When you run a site-targeted AdWords campalgn, you set the maximum price you want o pay for every thousand
impressians your ad gets on that site. This is called the max CPM. When yous run a fraditional AdWords keyword-
targeted campaign, you set the maximum price you want to pay every lime somecne dlicks on your ad. This is the
maximum cost per click, or max CPC.

Because iha two pricing systems are different, AdWords uses a system of effective CPM, or eCPM, to compare
and raak them. '

For keyword-targeted ads, the AdWords dynamic ranking system considers the ad's cost per click (CPC),
clickthrough rate {CTRY), and othier relevance factoes, all taken across 1000 impressions. The resulting
figure Is the ad's eCPM, or effective cost per 1600 impressions.

For any available ad position, the eCPMs of keyword-targeted ads are compared to each olher and to the max
CPM prices of eligible site-targeted ads. The highestrarking ad wins the position and is displayed to the user.

hitpsadwords.googl /support’binfindes pyfulld 1 (73 of 116)812/2005 8:35:12 AM
When a CPC ad is displayed, il is charged only if the user clicks on the ad. A CPM ad is charged for an impression whether clicked or not. No matter
which type of ad wins the posilion, the AdWords discounter moniloss Uhe corpefition and ensures that the winning ad is charged only what is

necessary fo maintaln its ranking above the next-highest ad.

Site-largeted ads can appear only on the Google content network, so at present that is the onfy place where site-targeted and keyword-targeted ads
tompela. On search results pages and cther Google Network properties, keyword-targeted ads continue to compate as they always have.

For more on CPM pricing, see How does CPM pricing work?

When you create a site-targeted campaign, the sign-up wizard will give you the chance to enter the
URLs of sites where you'd like your ad to run. You'll also be asked lo enter terms that describe the kind
of site you're looking for,

if the URLs you enter are part of the Google content network, you'll be able to select them for your ads. (if
not, you'll see a message telling you that they're not available.) The AdWords system will also use the sites
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and terms you enter to generate a list of other Google content network sites that may be a good fit for your
ads.

The final choice of sites is entirely up to you. Remember that wiih site targeting, your ad will run only on
siles which are part of the Google conlent network, and only on the individual sites you specify.

e

Site-targeted campaigns can include text ads, image ads, or both. Site-targeted ads appear in the same
format sizes and the same page positions as standard keyword-targeted ads.

Alfter setling your adverlising goals for a site-targeted campaign, the next step is to select the sites where
your ad will appear. Here are some Keys to creating an effective site list:

1. tist the sites where you know you'd like to advertise.
2. Expand your site list,

3. Group yOUr sites by theme.

4, Create yOUr campaign and your final list.

DN

Slep 1: List your preferred sites.

These are lhe sites where you already know you'd like to advertise. When you create your campaign
you'll enter these sites and then have the chance to see and select all those that are part of the Google
content network.

Slep 2: Expand your sile list.

H you know of only a few sites (or no sites) where you'd like {o advertise, list some sites you like on topics
that refate o what you're looking for. When you create your campaign the AdWords system can use those
sites {o generale a list of Google content network sites where you may want to advertise.

Siep 3: Group your sites hy theme.

Review your list and look for themes within the overall list. Consider creating separate Ad Groups with
highty specific ads for each of these smaller groupings. The more precisely you target your audience, the
better chance of success your ad will have.

Step 4; Create your campaign and select your final sites.

When you create your campaign, lhe set-up wizard will include a segment for Idenéifying and selecting sites.
As a first step you'll enter alf or part of your site list. We recommend that you enter muitiple site URLs, 1o
give the system the broadest possible view of your interests. The wizard will generate a list of the most
closely related sites in the Google content network. Then you'll be able to select your final site list from all
these available sites, ’

Wit SRSl G S0 ahoa

Site-targsted ads appear only on websites that are part of the Google
content network. This includes many adveriisers, large.and small, who run
AdWords ads on their content sites,

Site-targeted ads aren't eligible to appear on the Google search network, on
search resulis on Google.com, or on related Google properties like Gmail. If you'd
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like to appear in these locations, we suggest running a keyword-targeted
campaign.

hND!'ﬂadwordigmgh.mﬂsuppmu’binﬁndcx.py? 1 p=1 (74 of | L6)R/22005 8:35:12 AM
How:frusch & sife dergare ada tns R

Site-targeted ads raquire a max CPM price of US$2.00 per 1000 impressions. You may, of course, set
a higher amount. A higher max CPM increases lhe likelihood that your ad will appear regularly on
your selected site(s).

How a1 fnow it B site s poit Gtihe

The Google content network consists of thousands of sites of all types, large and small, professional and
personal. Because the roster of sites grows and changes day by day, we can't publish a list of sites. The
best way to check for an individual site Is to enter it in the sign-up wizard while creating a site-targeted
campaign. If that site is available, it will be listed for you lo select as a target site for your campaign.

$2.00USD. or the local cumency equivalent, is the fowest max CPM that advertisers can set.

¥t s maiifpissions

When you create a site-targeted AdWords campalgn, you'lf see the system's estimate of the maximum
impressions available per day for the sites you've selected. This is marked as 'Max. Impressions / Day' in
the sighup process.

Because site impressions vary from day to day based on many factors, the AdWords system can't predict
the number of impressions that a given site will have each day. Instead, the maximum impressions per day
offers an estimaled total of the available impressions for all the sites you've selected. This may help you
decide if you have selected enough sites to satisfy your advertising goals.

Note that the impressions per day is an estimate of the total page views for those siles -- not the number
of impressions your ad will receive. Your ad's total impressions will depend on your CPM pricing, the
popularity of the site with other site-targeted and keyword-targeted ads, and other factors.

Hok doos Sta targatng efoct iy

All AdWords advertisers now have the option of creating site-targeted campaigns. However, we anticipate
that many advertisers will continue to prefer traditional keyword-targeted campaigns. If you are akready
running keyword-targeted campaigns, you don't need to take any action - your ads will continue running as
they have been.

To learn how to create a site-targeted campaign in your existing account, please see this FAQ.

Keyword-targeted campaigns allow you to choose the keywords that will trigger your ads. Keyword-targeted
ads can appear on Google.com, on Google search pariner sites, and on content and partner sites in the
Guagle Network. Keyword-targeted ads are priced on a cost-per-click (CPC) basis: you set the price you'd
like to pay each time a user clicks on your ad, and you pay only when the ad generates a click.
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With site-targeted ads, you select the exact content sites on the Google Network where you'd like your ad to
appear, (Sile-targeted ads don't appear on Google.com or on search partner sites.) Pricing for site-targeted
ads is cost-per-impression, or CPM: you set the price you'd like to pay for each 1000 impressions, and you
pay for each impression whether a user clicks on your ad or not.

Both keyword-targeted and site-targeted campaigns are available to all AdWords advertisers. Each
can include image ads, though image ads also appear only on content sites in the Google Network.

edandkaywuﬁlargetédcau‘pagnsattli

Yes. Any individual campaign can conlain only site-targeted or only keyword-targeted ads and Ad Groups.
But you can run both site-targsted and keyword-targeted campaigns in your account at the same time.

¥ hanid max.@ﬂi\flot my site»ta;gated 59
You can change your max CPM on the Ad Group level of your campalgns Here's how:

. Log in to your AdWords account at hitp://adwords.google.com.
. . On the Campaign Summary page, click the name of the appropriate site-targeted
campaign. :

. . Click the name of the Ad Group you want {o edit.
- Click 'Edits Sites and CPMs’ (located above the graph).
. Set your new maximum CPM.
. Click 'Save.’

The sile tool helps you find and choose the Google Network sites where your site-targeted ads may run.

The site tool has two parts. In the identify Sites stage. you describe your site and the kind of sites where
you'd like to adverlise. in the Choose Sites stage, you select your aciual target sites from a list of
candidates presented by the AdWords system.

To identify your sites, follow these steps on the first page of the site tool:

1. 1. In the lefi-hand box, titled Sites, enter the URLs of any websites where you'd like your ad
to appear, At this stage, don't worry about whether the site is part of the Google Network or not.
2. 2. In the right-hand box, titled Descriptive Terms, enter single words which describe your site.

3. Click 'Continue.’ The URLs and descriptive terms you enter will be analyzed by the AdWords system
and then used to generate a full list of available Google Network sites. Enter as many URLs and terms as
you can: the more details you provide, the better the system will understand the kind of site you're looking
for.

Once you click 'Continue,’ you'll see the Choose Sites page, with a list of available Geogle Network sites
lhat match the details you entered.

A site must be part of the Google Network [?} to be listed as a candidate. if you request a site that's not
part of the Geogle Network, you'll see it listed under "View unavailable sites.” (For more details, see Why
is the site { want not available?)

Now it's time to choose your target sites:

1. 1. Check the box next to all sites where you'd like to advertise.
2. 2. Click "Add' to move those chofces to your list of selected sites.
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3. 3. Now click the ‘Refresh candidate sites' buiton. The system will analyze your choices and
create a refined list of candidates.

4, 4. Select and add more sites from the new candidate list. Click 'Refresh candidate sites' again.

5. 5. Repeat until you're happy with your final list of sites.

6. Click 'Continue’ to continue setting up your campaign. Each fime you hit 'Refresh,’ the AdWords
system analyzes the selections you've already made and uses them to find refated or similar sites. Then it
presents these sites for your constderation,

Of course, we can't guarantee that your ad will run on every site you pick. Some siles have a limited
amount of ad space avalilable, and you will be competing with other advertisers. Soms sites may not run
certain ad formals (like banners or wide skyscrapers) or may halt advertising for other reasons. We
suggest you experiment with several different sites over time and look for the combinations that work for
you.

AR individual site must be part of the Google Metwork in order tu be available for your site-fargeted campaign.
Being part of the Google Network means the site has agreed to run ads provided by Google, which in tumn allows
your AdWords ad to compete for that space.

The site must also be a content site in order (o ba available for site-targeled campaigns, Some sites on the
Google Network run ads only on search resulls pages, which can't be selected for site targeting. If you'd tike your
ads 1o appear alongside search results, or In retated preducts like Gmall, ry inning a keyword-targeted
campaign.

Itis atso possible that the site you selected may have opled out of sila targeting. Soma publishers, for reasons
of their own, prefer nof to run sitetargated ads.

AdWords quality commitiment : AdWords policies & security

s advords £00, te.comfsupportbinfindex gy Phutldump=1 {76 of 118)8/212005 8:35:12 AM

As a provider of space for advertisements. we cannot arbitrate frademark disputes betwaen adverlisers and irademark owners. As stated in our
Temns and Condillons, advertisers are responsible for ke keywords and ad content thal ey choosa to use. We ancorrage trademark owners to
resolve their dispiies directy with our advartisers, particulary because the advetisers may have similar advertisements on olher sitos.

As acourlesy, we are willing to perform a limited investigation of reasonable complalnts. Please note that any such investigation will only affect ads
served an or by Goagle. Trademark claims can be filed at any ime. The tragemark owner 15 not required te be a Google AdWords advertiser in order
{o file a ctaim.

To leam more about Google's trademark policy and how to submit e rademark complaint, please review our full tademark complaint procedure,

As part of our ongoing effort to improve the Google AdWords program for advertisers and
users, we may periodically update the AdWords Terms and Conditions. All AdWords
advertisers are required to accept these new Terms and Conditions in order to advertise with
the AdWords program.

You may have received an email from us, or a notification within your account, requesting that
you log in and accept our new Terms and Conditions. You can do so by logging into AdWords.

Please note that you'll have a limited amount of time (generally 30 days from your initial
natification) to log in and accept the new program Terms and Conditions; otherwise, we'll need to
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pause your account until you've made this change. To avoid interruption of your AdWords
advertising, we recommend that you log in and make this change as soon as possible.

G G

The Google AdWords Editoriat Guidelines, posted on the Google AdWords website, define the
criteria afl

ads must mest in order to run on Google. These guideiines focus on helping you to create clear,
effective, and informative ads in order to meet your sales goals. Piease review the Editorial
Guidelines before creating your ads.

Please note that in the cases where minor chianges to your ad are required in order to comply
with aur Editorial Guidelines, a client service representative may edit your ad for you. This
prevents your ad from being disapproved and lets your ad continue to run.

Here are a few examples of edits we may make for you:

-Removing an excltamation point
-Removing or adding an extra space
.Fixing a spelling error

Google shall not be responsible in the event that a change is not made to your ad text and a
disapproval resulls. Therefore, it is important for you to follow the Editorial Guidelines to help
ensure that your ads continue running.

We allow affiliates to use AdWords advertising. Please note that we'll only
display one ad per search query for advertisers sharing the same top-
tevel domain in the Display URL. This means that if you're an affiliate
advertiser, your ad may not show for a query because ancther affiliate or
the website that runs the affiliate -

program also has ads using the same (or a similar) domain in the

Display URL. Also, your site should not mirrer (be similar or nearly
identical in appearance to) your parent company's or another

advertiser's site.

For example, for the domain google.com, we would determine the
following URLs and Display URLs to be equivalent:

.home.google.com
~www.google.com
.google.com
SWw.google.com/home
~www.Google.com

ds.googte. /! findex py?fulldump=1 (77 of 116)8/2/2005 3:35:12 AM
However we'd determme the following Display URLs to be distinct, since each has a
different top-level domain:

-www.google.co.uk”
www.google.fr
~www.google.com
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~www.google.edu

*Domains with a country-specific extension are considered distinct.

For more information about this change, please review the January 2005 Geogle
AdWords service announcement,

Helpful Definitions:
Disptay URL

This is the URL displayed on your ad to identify your site to users. This URL displayed is limited
to 36 characters; it need not be the same as the URL your ad links to, but it should be an actual
URL that is part of your site.

Domain

Website domains are a naming procedure by which web users may identify a particular website
address and location (e.g., www.google.com}. They are usually made up of two parts: a name
and a category. The following are common URL domain categories: .com (commercial), .edu
{educalion), and .gov {government). Domain categories can also be country-specific, for example:
.t {France) , .br {Brazil), or .jp {Japan). In some cases, one category is appended to another
category, for example: examplename.co.uk, examplename.com.ph, examplename.org.uk).

in order to ensure that AdWords ads benefit our users, advertisers, partners, and Google, we
maintain high standards for ads accepted into the AdWords program. For a list of affected
products and topics, please see our Content Policy. Application of content policies will always
involve an clement of discretion, and we reserve the right to reject or approve any ads.

i shild) e o

_All AdWords ads are reviewed by our support staff to make sure they meet Google's guidelines.
Ads may be disapproved for various reasons, including misspellings, inappropriate content,
unacceptable phrases like 'Click here,' or other details which can make ads confusing, offensive
or ineffective,

When an ad does not meet Google's guidelines, we temporarily block the ad from running and
send you an email explaining why. You'l also see the word "Disapproved' next to any such ad in
the Campaign Management section of your AdWords account. To get the ad running, just
make the appropriate edils and save your changes. Your ad will be automatically resubmitted to
us for review.

For more details, please review the Editorial Guidelines and Content Policy.

As of May 2004, all online pharmacy-related ads and keywords for U.S.-
targeted campaigns must be associated with a valid SquareTrade ID.
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Make sure you're prepared,

Learn more about the Google Online Pharmacy Qualification Program.

hitps:/fadwords.gongle. Ssupportbindindex. py? fulldump=1 {78 of | 16)8/2/2005 8:35:12 AM

Already a member of the SquareTrade Licensed Pharmacy Program?
Submit your SquareTrade 1D in your AdWords account,

Don’t yet have a SquareTrade ID?
Learn more and submit an application.

Not an online pharmacy or pharmacy affiliate?

Let us know. if you feel that this policy does not apply to you, please send us an exception
request through your AdWords account. You'll be notified by email when we've reviewed your
account.

Based outside of the U.S. or Canada?

The SquareTrade program is only open to pharmacies based in the U.S. or Canada. If you
are based outside of these counlries, you must edit your AdWords location targeting list to
remove the U.S.

AdWords doesn't allow unusual spellings, double exclamation points or other visual gimmicks.
Our goal is to provide users with useful, relevant ads in a format that is easy to read and
understand.

Our experience shows that your ad will gather the best response if you simply describe your
product or service in a clear and straightforward way. The more you emphasize the unique
benefits of your product or service, the better your results will be.

i your business name requires unusual spelling, exlra capHal lstters or other unique characters,
you can request an exemption from the AdWords team when you build your ad. The AdWords
team will review and, if appropriate, approve the wording of your ad.

For more information, please see the AdWords Editorial Guidelines.

We understand that making an advertising purchase onling involves a
great deal of frust on your part. We take this trus! very sericusly, and
make it our highest priority to help ensure the security and confidentiality
of the information you provide. Google uses industry-standard SS1.
(secure socket layer) technology to protect every interaction you have
with the AdWords system. This protecls your credit card and other
personal information. Once we receive your information, we not only store
it behind a firewall, but also encrypt the sensitive payment information.
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When payment information is submitted through our online form,
Google works with third-parties to verify and process your information,
Your personal information is encrypted and neither Google nor our
payment pariners share or sell your personal information. The
information you provide us will be used solely for the purpose for which
it was provided. For more details, please see our Privacy Policy.

For credit card & debit cards: Billing information is checked against the
account information by our third-

party payment processor, If the information submiited is invalid, the
payment information will not he

accepted. If the information is valid but there are discrepancies, the third-
party processor returmns a fraud

score based on the number of discrepancies between the credit card
account and the AdWords account

information. High fraud scores are flagged by our system for review by
an AdWords Specialist,

For bank transfers: Google works with a third party service provider to
offer our advertisers a secure way to fund their AdWords accounts using
bank transfers in many different currencies and countries. When you pay
via bank transfer, your payments are initially sent to a bank account in
your country that belongs to this service provider, which securely
processes your payment and sends the funds to Google. Since your
payment is made to this third party, their name or the name of their local
subsidiary may appear in the bank account name to which you are
insiructed to fransfer your payments.

If you have any other payment or security concerns, please contact us.
One of aur client service specialists would be happy to answer your
questions.

lilvps:=Hadwonds oogle.tomlsgppt_nd‘binl’mdn yZiullduop=1 €79 of 1 16)8/2/2005 8:35:12 AM
et -k oy

Our AdWords Specialists review all of our ads to ensure that they meet Google's adveriising
standards.

These standards can be found in our Terms and Conditions and in the Google AdWords Editorial
Guidelines. Google strongly believes in the importance of relevant, high-quality advertising, which
benefits both our advertisers and Google users. By creating clear, well-targeted AdWords ads,
you'll reach your potential customers more effectively and help ensure a positive user experience
that wilt build users’ confidence in AdWords ads. The result will be higher traffic to your site,
increasing the potential return on your ad investment.

In May of 2004 we began requiring that all online pharmacy advertisers and affiliates targeting the
U.S. with their AdWords ads be 2 member of the SguareTrade Licensed Pharmacy program. To
be fair to all of our pharmacy advertisers, we make no exceptions. if you have not been granted a
SquareTrade seal, we are unable to show your ads in the U.S. or Canada.
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Partnering with a 3rd party to verify the eredentials of online pharmacy advertising through
Google AdWords helps enhance the integrity of the online prescription drug market place as well
as the Google AdWords program. Users gain security, knowing that onfine pharmacies found
through Google AdWords are trustworthy. And users are more likely to complete a transaction
with a business they know they can trust.

H you are targeting the U.K., you may not include prescription drug names in your ad text or
keyword list.

We created the Editorial Guidelines to help improve your ad campaigns as well as the Gaoogle
user experience. If we see that your ads don't follow these guidelines, we will let you know and
offer suggestions on how to improve your ads. Often, our systemn will automatically detect when
your ads should be refined. In this case, you may receive a message when you create your ads,
or you may notice a link {under the affected Ad Group in your account) o a diagnostics page
detailing the possiblae issues with your ads.

Our AdWords Specialists review your ads and can help you oplimize your campaigns. If your ads
do not meet our guidelines or are performing poorly, we'll notify you by email. We'l often stop
running your ads until you're able to make the necessary changes. As soon as you've made and
saved the changes, your ads are automatically resubmilted to us for review.

The cookie that Google adds to a user's computer when hefshe clicks on an ad expires in 30
days. This measure, and the facl that Google uses separate servers for conversion tracking and
search results, protects tha user's privacy.

Users who don't wish to participate in fracking activities can easily not accept this cookie by
setting their Internet browser user preferences. These users will simply not be included in your
conversion fracking statistics.

Google is committed to providing an optimal user experience as well as
giving you the most effective online advertising possible. To do this, we
need the help of both our advertisers and users. If you're an advertiser,
you can help by creating conclse, informative, and well-targeted ads.
Since such ads often generate the highest clickthrough rates (CTRs),
you'll see campaign performance improvements, and our users will see
usefil, informative ads.

Google is not responsible for advertisers' websites including, but not
limited to maintenance of such web sites, order entry, payment
processing, shipping, cancellations, returns, or customer service.
However, we value customer service and hope that our advertisers
provide quality services. If poor service is rendered by one of our
advertisers, suggest that you contact the Better Business Bureau or
Consumer Affairs division of the city where the company is located, as
they will be able to investigate your case and act on your behalf.

hitps:#Hadwords. google com/suppostbinindex py?Galldump=1 {80 of L 16)2/2/2005 8:35:12 AM
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Such organizations provide the most effective forum for addressing cases of consumer
dissatisfaction.

B T

Yes. Google's security standards are stringent; we use data encryplion and secure servers, and
do not collect or store personal information. In addition, only those pages containing the Google
conversion code are tracked.

o does Gaogl ianidie peisiial datnt”

Google is firmly committed to the privacy of our advertisers and users. While Google does add a
cookie to a user's computer when helshe clicks on an ad, this cookie expires in 30 days, and
Google dogs not associate a user's search activity with his/her ad click history. Further, Google
does not collect or track personaily identifying information, and does not reveal individuat
information to third parties.

Users who do not wish to paricipate in tracking activiies can easily disable Google's
conversion fracking cookie in their Internet browser's user preferences settings. These users
will not be included in your conversion tracking statistics.

For more information on Google's privacy policy, please click here.

No. The information you provide will only be used by Goagle, and only in our efforts to serve you
better. We will not share your personat information, unless required to resolve a charge dispute or
by legal process. Please also see our Privacy Poficy and Terms and Conditions,

We understand that making an advertising purchase online involves a great deal of trust on your
part. We take this trust very seriously, and make it our highest priority to ensure the security and
confidentiality of the information you provide. Google uses industry-standard SSL. {(secure socket
layer) technology to protect every interaction you have with the AdWords system. This protects
your credit card and other personal information. Once we receive your information, we not only
store it behind a firewall, but afso encrypt the sensitive credit card information.

When credit cards are submitied through the secure online form, they are checked against the
account information by our third-party credit card processor. If information submitted is invalid, the
credit card will not be accepted. if the information is valid but there are discrepancies, the third-
party credit card processor returns a fraud score based on the number of discrepancies between
the credit card account and the AdWords account information. High fraud scores are flagged by
our system for review by an AdWords Specialist.

AdWords quality commitment : AdWords click quality

- Google’s proprietary technology analyzes clicks to determine whether
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